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Course 2 - Navigate QuickBooks Online

Training at a Glance

Use this as a guide to select specific activities you want to cover.

Training ata Glance

TOPIC CONTENT
SALES & REVENUE ® Sales receipts
TRANSACTIONS ® Invoices

® Payments

® Deposits
EXPENSE & PURCHASE ~ ® Checks
TRANSACTIONS ® Expenses

e Bills

e Bill payments
ADDITIONAL e Time tracking
TRANSACTION TYPES ~ ® Bankdeposits

e Transfers

® Journal entries
OTHER TOOLS ® Banking Center

® Bank reconciliation

® Closing the books
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QuICKBOOKS ONLINE TEST DRIVE

Most exercises contained inside this handbook can be completed using a QuickBooks Online “test
drive” file. The test drive uses a sample company file called Craig’s Design & Landscaping Services. It
can be accessed through the following link to a sample QuickBooks Online Plus company:

Craig's Design & Landscaping

You don't have to create an account or sign in to access the test drive file; just complete the security
validation and click Continue.

This test drive is designed for you to explore and try out new things without worrying you will break
something or make a mistake. It is not designed to retain any changes you make. (Although you
should change the Sign me out if inactive for setting to 3 hours if you want to give yourself plenty of
time.) Once you close this QuickBooks Online test drive company it is completely refreshed, so
remember to allow sufficient time to complete each task.

Some exercises are designed to be completed in an actual QuickBooks Online company. These
courses use a QuickBooks Online Plus company.

NoTE: When you are working in an actual company file (not a test drive company), you may see Left
Navigation bar tabs that differ slightly from what you see here. If that is the case, the actual company
is being viewed in Business View (as opposed to Accountant View). The steps in this course are
following the Accountant View option. If you are in Business View, click the gear icon in the top right
and select Switch to Accountant View (and it can be toggled back to Business View).

All QuickBooks Online companies, including test drive, can be toggled between Accountant and
Business View.
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YOUR COMPANY LISTS TOOLS PROFILE
Account and settings Al lists Order checks 3 Feedback
Manage users Products and services Import data Privacy
Custom form styles Recurring transactions Import desktop data
Chart of accounts Attachments Export data
QuickBooks labs Custom fields Reconcile
Tags Budgeting
Audit log
SmartLook

Resolution center

You're viewing QuickBooks in Business view. Learn more Switch to Accountant Viewuﬂ"ﬂ
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Topic 1: Sales and Revenue Transactions

Whenever you set up a new area of QuickBooks, you need to review the Account and Settings
related to that area. Before you go into Account and Settings, you need to make sure you
understand the different types of sales and revenue transactions.

Estimates are non-posting transactions that provide your customers with information on what
you think you are going to charge them. Think of an estimate as a quote or proposal.

Invoices are the sales transactions used when you want the customer to pay on account. An
Invoice will increase accounts receivable, generally increase income and perhaps sales taxes if
they are being collected.

Receive payment is the type of transaction used to receive payment against an invoice. A
Receive payment decreases accounts receivable and increases either a bank account or
Undeposited Funds.

Sales receipts are the sales transaction used when you receive payment at the time of sale; it has
no effect on accounts receivable. It increases income and increases either a bank account or
Undeposited Funds. Think of it as the equivalent of a cash register receipt when you buy a pack
of gum at the store.

Credit memos are used when a customer returns something or negotiates a lower price after the
original invoice has been issued. This creates a credit in accounts receivable that can be used
against future invoices.

Refund receipts are also used when a customer returns something or negotiates a lower price,
but with a refund receipt you are refunding their payment. It has no effect on accounts
receivable. Refund receipts are often used if the customer to whom you are refunding the money
has no outstanding accounts receivable balance with you.

Delayed charges and credits are only available in QuickBooks Online Essentials, Plus and
Advanced; they are non-posting transactions that reflect a potential revenue increase or
decrease, as they are reminders to add these charges or credits to future invoices.

All these transactions relate to monies coming in. Most of these transactions can be launched from
more than one access point, whereas others can be launched only from one.
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APPROPRIATE SALES-RELATED SETTINGS

Account and Settings

Click the gear icon to access the Account and Settings under Your Company.

YOUR COMPANY LISTS PROFILE
Account and settings =5 COrder checks & Feedback
Manage users Products and services Import data Privacy

Custom form styles

Recurring transactions

Import desktop data

Chart of accounts Attachments Export data
QuickBooks labs Custom fields Reconcile
Tags Budgeting
Audit log
SmartLook

Resolution center

You're viewing QuickBooks in Accountant view. Learn more Switch to Business view

There are several tabs down the left side of Account and Settings to set the preferences you want to
use with the company file. The Sales tab is its own category, but there are also sales-related settings
under the Advanced tab.

NOTE: In an actual QuickBooks Online company (as opposed to the test drive company below), you
would see more tabs down the left side, including ones for Billing and Subscription, and one for
QuickBooks Payments. Signing up for QuickBooks payments lets your customers pay online by ACH
or by credit card (fees apply).
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Account and Settings @ Hep M

Sales form content Preferred invoice terms Net 30
Preferred delivery method Print latar
Eansa Shipping

off

Custom fields

Products and services

Late fees

Progress Invoicing Create multiple partial invoices from a single estimate off
Messages Default email message sent with sales form:

Reminders

Customize Sales Forms

The first setting under the Sales tab allows you to customize the sales forms. Click Customize look
and feel. Click New Style, then decide if you are going to create a new style for an invoice, estimate
or sales receipt. Click Invoice.

New style v

Estimate

Custom form styles

< Al lists
NAME FORM TYPE LAST EDITED

Sales receipt

Mo datz availzble

Change the name of the invoice template from the generic My INVOICE Template - DD-YY (xxxxx) to
something meaningful.

In the Design tab, you can rename the title of this sales form, choose your template (Airy new, Airy
classic, Modern, Fresh, Bold or Friendly), upload up to 10 logos (you can use only one at a time on a
form), add color and choose your font. You can also print your in-progress template to test how it
looks on plain paper or letterhead with various margins or preview a PDF of the form.
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Create invoices that turn heads and open wallets Shara feedback X

] Craig's Design and Landscaping Services

123 Siera Wiy
San Pablo. CA 87808

[ Esther's Default Invoice Template
noreply@quickbooks.com

b Invoice
BILLTO INVOICE#
Smith Co DATE
123 Msin Street DUE DATE
— City. CA 12345 TERMS Net 3
Airy new Airy classic Modern Fresh Bold Friendly
DATE ACTIVITY ACTIVITY aTy RATE AMOUNT
12/01/2018 tem name Description of the item 2 225.00 450.00
01122018 Item name Description of the item 1 225.00 225.00
e Add your unique logo
- Splash on some color [ LT R ———— e75.00
-13.50
10125
577625
BALANCE DUE $776.25

I:f Get choosy with your font

| Whenin doubt, print it cut

( ) €3

Click Content tab = pencil icon in any of the three sections (Header at the top, Table in the middle
or Footer at the bottom) to review and edit the content in that section; you can also edit labels,
column widths and so forth.
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Make sure to look at the options for billable expenses and billable time if you invoice based on time
and expenses. In the Table area you can include the employees’ names on the form, and you can
group activities by day, week, month or type, and have the groups subtotaled. If these options are
not visible you can make them appear by clicking Show more activity options.

Create invoices that turn heads and open wallets Sharefeedback | X
Table Craig's Design and Landscaping Services

Account summary
[_] Show on invoice

Activity table

COLUMNS EDIT LABELS AND WIDTHS

i ] Date
DATE ACTIVITY ACTVITY ary RATE AMOUNT
120172018 Hem name Deseription of the item 2 22500 450,00
o @ Product/Service 011212016 Item name Description of the ftam 1 22500 22500
[7] include description here

[ emeeany

B @ Description
[7] incluce Quantity snd Rete

B @ Quantity

H [ Rate
o @ Amount
H O[] sKu « »
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The Emails tab allows you to set the default email subject and message that accompanies the sent
form (the Standard email), as well as the format of any Reminder emails you might send.

Create invoices that turn heads and open wallets Shara foedback X
[E=4p) e Subject Inveice from Craig's Design and Landscaping Services
o . ) From quickbooks@notification.intuit.com
~ How your invoice appears in emails
Full details -
®) Summarized details
(] FOF Aached INVOICE 12345
~ Standard email Craig's Design and Landscaping Services

Editthe email your customers get with every invoice

Subject

Invoice from Craig's Design and Landscaping Services

DUE 02/12/2016

M Usegreeting | pear v [FullName] v $776 25

Message to customer

Your inveice is auached. Please remit payi

ment et your earliest convenience. Print or save
Thank you for your business - we eppreciate it very much.

Sincerely Powered by QuickBooks
Craig’s Design and Lendscaping Services

Dear [customer full name]

Your invoice is attached. Please remit payment at your earliest convenience
» Reminder emai Thank you for your business - we appreciate it very much

sincerely,
Craig's Design and Landscaping Services

Crr) D

Sales Form Content

This section of the Sales tab of Account and Settings allows you to set options such as Preferred
invoice terms and Preferred delivery method, which can be changed on an actual individual sales
form. The Content section sets defaults. Here you specify if you allow custom user-entered
transaction numbers on sales forms (as opposed to a numbering sequence put in place by
QuickBooks, with no option to change the numbers) as well as a service date column. You can also
add additional line items such as shipping, discount, deposit, tips fields or tags.
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Products and Services

In this section of the Sales tab in Account and Settings, you identify if you want to Show the
Product/Service column on sales forms so the drop-down list of products and services is available.
Also, this where you turn on the preference to track inventory and price rules. Inventory tracking and
price rules are available only in QuickBooks Online Plus and Advanced.

Products and services Show Product/Service column on sales forms (2) [ @
Show SKU column & D
Turn on price rules ®

Track quantity and pricefrate (&) (@

[ @)

Track inventory quantity on hand (@

—
| Cancel |
\_ y
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Late fees

You can turn on Late Fees, which applies a default charge to overdue invoices, either in the form of a
flat fee or a percentage of the remaining balance. You can define the frequency, if it is an upfront,
one-time fee, as well as the grace period and the terminology to be used for the charge (e.g., Late
fee). Lastly, you can specify if sales tax is to be applied to this charge.

Late fees Default charge applied to overdue invoices ()

After you turn on late fees, you can customize settings for individual
customers from your dashboard under Customers.

Type
Flat fee

@ Percentage of remaining balance

Percent (%) Frequency

:

l:‘ Apply an upfront, one-time flat fee

Grace period

Grace period begins the day after the due date. Late fees will not
accumulate during that time.

None v

Appears on invoices as

If you delete this item from the Products and Services list, late fees will no
longer apply.

Late fee

Apply Sales Tax

»

There may be limits on the amounts and types of fees you may charge to
your customers. You should confirm the requirements in your jurisdiction
and how they relate to you.

P ~
| Cancel )
. /

Progress Invoicing

You can create multiple invoices from an estimate with Progress Invoicing, allowing you to keep
track of the progress of a job. It is available in all subscription levels of QuickBooks Online. This is the
section in the Sales tab of Account and Settings where you turn on the ability to perform Progress
Invoicing.

Progress Invoicing Create multiple partial invoices from a single estimate (:J

.-/.. ..\-.
| Cancel |
" Y,
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Other Sales Settings

The Messages setting allows you to create default email forms when emailing sales forms.

Messages Default email meksage sent with sales forms

Use greeting| Dear ¥ [Full Name]

Salesform (3

|rvoice ¥ Use standard message

Email subject line
Invoice from Craig’s Design and Lands:

Email message

Your invoice is attached. Please remit payment at your earlisst convenisnce.

Thank you for your business - we appreciste it very much.

Sincerely,

Craig's Design and Laendscaping Services
D Email me a copy at noreply@quickbooks.com
Copy (Cc) new invoices to address

Blind Copy (Bcc) new invoices to address

Sales form

Estimate @
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The Reminders setting, like the Messages setting, allows you to create default emails when sending
reminders.

Reminders Default email message for invoice reminders ~
Use [Invoice No.] and [Company Name] as placeholders in the email.

Subject line

l Reminder: Your payment to Craig's Design and Landscaping Servi I

Use email greeting | Dear v l [Full Name] v l

Email message

We're sending a reminder to let you know that invoice [Invoice
No.] has not been paid. If you already paid this invoice or have
any questions, let us know!

Have a great day,
Craig's Design and Landscaping Services

D Send a copy to noreply@quickbooks.com

Automatic invoice reminders ()

Automatic email reminders only apply to new invoices. Turning off automatic reminders
removes them from all invoices.

Reminder1 (3da Off v
Reminder 2 [On due date) Off v
Reminder3 (3 day(s Off v

= -

Online delivery settings relate to emailing your forms and what you want the customer to see. There
are options of sending as plain text, HTML or using an online invoice.

Online delivery Email options for all sales forms

® Show short summary in email

Show full details in email

PDF Attached

Additional email options for invoices

Plaintext +

(o) GEEED
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Topic 1: Sales and Revenue Transactions

There are a couple of preferences to choose from regarding Statements. See below:

Statements @ List each transaction as a single line (@

List each transaction including all detail lines

Show aging table at bottom of statement (2)

.-‘/.l l-\-.
[ Cancel |
.\-. .-/.

Advanced Settings

For more sales-related preferences, look at the Automation section of Advanced settings.

Automation Pre-fill forms with previously entered content ()
Automatically apply credits (2)
Automatically invoice unbilled activity (&
Automatically creste invoices and don't notify me v

Schedule

Automatically apply bill payments (%)

.-".. -l\-.
[ Cancel |
M A

L@
L@
L@

Monthly - on | day ¥ 1st w | ofevery

L@

months(s)

If you turn on the preference to Pre-fill forms with previously entered content, QuickBooks Online
will copy the information from the last transaction using the same customer.

If you turn on the preference to Automatically apply credits, QuickBooks Online will apply any
available credits to the next invoice. Beware of turning on this or any other automation preference. It
may be that you dont want to apply the credit to the very next invoice, but instead to some future

invoice.

QuickBooks Online 2021 Client Training
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Topic 1: Sales and Revenue Transactions

You can turn on a preference to Automatically invoice unbilled activity. Once this preference is

turned on, you then choose one of the following automation options:

Automatically invoice unbilled activity (@

Automatically create invoices and don't notify me @J
Automatically create invoices and don't notify me
Automatically creats invoices and notify me

Auto Remind me to create invoices

L@

¥ 1 months(s)

@

In addition, you specify a schedule regarding how often (in days, weeks, months or years) and when

this automation function runs.

You need to understand the ramifications of the Automation preferences to know if they make sense
for you. If you have problems with accounts receivable, check these settings.

Schedule

(=1
[1T]
b=
4

I D":h|'_-,' o on

1zt v | of every | 1 months(s)

QuickBooks Online 2021 Client Training
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ALTERNATE ENTRY POINTS TO ENTER SALES TRANSACTIONS

Customer Center

The Customer Center, accessed by selecting Sales > Customers in the left navigation bar, is a
dashboard for adding, editing and reviewing customers with whom your QuickBooks Online
company does business. The list of customers can be printed or exported to Microsoft Excel®, and it
can be sorted by various parameters or filtered. In the far-right Action column, beside each customer
listing in the Customer Center, is a drop-down box from which to create transactions such as
invoices or estimates, send a reminder of a balance due, or print or send a statement. In addition,
batch actions can be performed for one customer, selected customers or the entire list: send or print
statements and send emails directly from within QuickBooks Online.

Overview All Sales Invoices Payment Links Customers Products and Services

Customers cz==Ip

Unbilled Last 365 Days Unpeid Lest 365 Days Paid
$0 $750 $1,526 $3,136
0ESTIMATE 3UNBILLED ACTIVITY. 10 OVERDUE 12 PAID LAST 30 DAYS

’ @ Do you organize sub-customers &3 projects? You can convert the first level of sub-customers into their own project. Convert now x

| Bsteh sctions ~, ] Q

[ Crestestatements COMPANY PHONE OPEN BALANCE
Email h

. (650) 555-3311 $239.00 Receive payment v
Mske inactive
Selectaustomerype |

O o — (415) 4426538 585.00 Recaive payment w

's Windsurf Shop

Cool Cars

= (415) 555-9933 80.00 Create invoice v
Cool Cars

Diego Rodriguez [ (650) 555-4477 $0.00 Create invoice v

—
Dukes Basketball Cam)

] I Camp (= (520) 420-5638 $0.00 Create invoice ¥

Camp
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Enter Transactions from the Customer Center

@
o Step by Step: Create an Estimate

There are several ways to create an estimate in QuickBooks Online. To create an estimate from the
Customer Center, follow these steps:

1. Select Sales > Customers from the left navigation bar.

2. If necessary, remove any filters from the search bar at the top of the customer list to produce a
full list of customers.

T Batch actions + Q,

D CUSTOMER / PROJECT + / COMPANY PHONE

3. Select the drop-down box in the far-right column for Diego Rodriguez - Create estimate.

CUSTOMER / PROJECT & / COMPANY PHONE OPEN BALANCE
Amy's Bird Sanctuary () (55015553211 s239.00
Bill's Windsurf Shop [

(415) 444-6538 $85.00

‘?ODI —Cars = (415) 555-9933 £0.00

N I I

Diego Rodriguez [] (650) 555-4477 $0.00

4. Complete the on-screen estimate for Diego Rodriguez with the desired date, expiration date of
the estimate (if any), products and services of your choosing, the quantity, description (override
the description if you want) and rate (override the rate if you like) of each and the sales tax (check
the Tax box for specific items, then select the sales tax to be applied in the drop-down box in
the footer).

5. Complete any other desired fields such as Discount and Message displayed on estimate.
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6. Select Save and close or (by clicking the drop-down next to Save and Send) Save and new.

() Estimate B @ Hep X

Email CofBes AMOUNT

$2,250.00

Tags (@
# PRODUCT/SERVICE DESCRIPTION ary RATE AMOUNT Tax
i Design:Design Custom Design by Esther 15 50 2,250.00 il
o
Add lines Cloar all ines Add subtotal Subtotal $2,250.00
Message displayed on estimate Taxsblo sublotsl $0.00
it
Discount parcant = $0.00
Massage displayed on statement Total $2,250.00
Estimate Total $2,250.00

@ tnchermnts Mo sioe: 2008
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@
o Step by Step: Create an Invoice from an Estimate

To create an invoice from the estimate you just created, the easiest way to find that estimate is from
the Money Bar in the Customer Center.

1. Select Sales > Customers from the left navigation bar.

2. Click the Estimates rectangle in the far-left section of the Money Bar to display a list of open
estimates.

$750 $3,136
3 UNBILLED ACTIVITY 12 PAID LAST 30 DAYS

3. Locate Diego Rodriguez on the list of open estimates.

T Batch actions v Q
D CUSTOMER / PROJECT & / COMPANY PHONE OPEN ESTIMATES ESTIMATE AMOUNT ACTION
[] DiegoRodriguez [] (650) 555-4477 1 Open estimaie $2,250.00 Start invoice

4. Find the estimate you want to turn into an invoice, then select Start invoice at the far right.

T Batch actions v Q,
[]  CUSTOMER/PROJECT « / COMPANY PHONE OPEN ESTIMATES ESTIMATE AMOUNT AcCTION
[] Diego Rodriguez [ (650) 555-4477 1 Open sstimate $2,250.00 S‘“fﬁ vvvvv
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5. Add the open estimate from the drawer on the right.

Topic 1: Sales and Revenue Transactions

(% Invoice

Tegs @
# PRODUCT/SERVICE () DESCRIPTION ary RATE
Add lines Claar allines Add subtotal
Massage on inwolcs
Thank you for your business and have s grest dey!
i

Massage on statement

@ dtschents M s: 2008

javascriptvoid(D)

AMOUNT

Subtotal

Taxable subtotal

Discount parcent ¥

Total

Balance due

BALANCE DUE

1A%

$0.00

$0.00

$0.00

$0.00

$0.00

Bekeatowr &3 @) Help X

>

Add to Invoice
Filer by

All dates v
Add all

Estimate #1001

$2,250.00
SasiamQesign by Esthe

Add

-

6. Make changes to the already-populated invoice, as required.

7. Select Save, Save and close (by clicking the drop-down box next to Save and Send), Save and

new, or Save and share link.

& Invoice

1 linked Estimate

c.:xjine;' . i C\:\omol omail CefBee
Billing sddrass 'Tm - Dus date
Togs @
# PRODUCT/SERVICE DESCRIPTION ary
Add lines Cloar alllines Add subtotal

Mossage on invoica

Message on statement

AMOUNT TAX

@ [

[}
Subtotal $2,250.00

Taxable subtotal $0.00
Discount parcent $0.00
Total $2,250.00
Balanc

Broesow G @ rop X

BALANCE DUE

$2,250.00
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When you create an invoice from the estimate, you can change the quantity of the line items on the
invoice. If you are invoicing for a smaller quantity than on the estimate you have the option for
QuickBooks Online to keep track of the quantity of each item on the original estimate and the
cumulative number of each item sold on subsequent related invoices. For this, turn on Progress
Invoicing. It will affect the number of each item available to bring over to future invoices from the
same estimate.

NorTE: If you do not want to invoice for the entire amount of the estimate, you can perform progress
invoicing, which is available in all subscription levels of QuickBooks Online. First, ensure that Progress
Invoicing is turned on. To do this click the gear icon - Account and Settings under Your Company
- Sales tab 2 Progress Invoicing = pencil icon (or click anywhere in that section) and toggle
Create multiple partial invoices from a single estimate. Then click Save and Done.

Account and Settings @ Help N
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@
o Step by Step: Create an Invoice for Unbilled Activity

You can also easily create invoices for any unbilled activity.
1. Select Sales > Customers from the left navigation bar.

2. Click the Unbilled Activity rectangle in the left section of the Money Bar to display a list of
unbilled activity.

@ Giiickbooks = Sample Company & wepe: Quap Q. Q& @
Overview All Sales Invoices Payment Links Customers Products and Services
TR ETTERY, v cmomer |+

Unpeid Last 365 Days Peid

$1,526 $3,136
10 OVERDUE 12 PAID LAST 30 DAYS.

3. You could click Start Invoice in the far-right column from here to see the unbilled activity.
Instead, however, click Unbilled activity for Amy’s Bird Sanctuary.

Unbilled Lest 365 Days

$750

3UNBILLED ACTVITY

Overview All Sales Invoices Payment Links Customers Products and Services
e Y e coorr | v
Unbilled Lest 365 Days Unpeid Lest 365 Days Peid
$750
$0 3JUNBILLED ACTVITY $1,526 $3,136
OESTIMATE 10 OVERDUE 12 PAID LAST 30 DAYS
~
l @ Do you organize sub-customers as projects? You can convert the first level of sub-custamers into their own project. Convert now X
A Batch actions v Q,
[T] | CUSTOMER/PROJECT & / COMPANY PHONE UNBILLED ACTIVITIES UNBILLED AMOUNT ACTION
O By (= (650)555-3311 1 Unbilled activity $375.00 Start invoice
Amy's Bird Sanctuary
Video Games by D.
[[] VideoGamesbyDan [ (650) 555-3456 2 Unbilled sctivities $375.00 Start invoice

Video Games by Den

s 12 Next Lsst
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4. Find the one Time Charge activity that is outstanding (unbilled) for this customer; it will display
Start Invoice in the far-right column. Click Create Invoice.

Iz Amy's Bird Sanctuary = <

Amy's Bird Sanctuary | 4581 Finch St Bayshore, CA 94326
Add notes
Transaction List | Projects Customer Details Late Fees

J( Batch actions v ) ( Filter v )

DATE v TYPE NO. MEMO

04/22/2021  Payment

04/06/2021  Payment

04/06/2021 | Credit Memo 1026

oo ooooo

04/01/2021  Invoice 1021

04/21/2021  Payment 6552
04/20/2021  Time Charge Custom Design
04/20/2021  Invoice 1001 Frontyard, hedges, and side

Crested by QB Online 1o link..

DUE DATE

04/22/2021

04/21/2021

04/20/2021

05/20/2021

04/06/2021

04/06/2021

05/01/2021

BALANCE TOTAL STATUS
50.00 -$220.00 Closed
50.00 -$108.00 Closed
$0.00 §375.00 Open
30.00 $108.00 Paid
$0.00 $0.00  Closed
50.00 -$100.00 Closed

$239.00 $459.00 Overdue

$239.00
OPEN

I $239.00
OVERDUE

1-90f 9

ACTION
Print w

Print »

Receive payment »

NoTE: If you have multiple activities listed here (instead of just one), you can start an invoice for one
unbilled activity and bring other unbilled activities in from the drawer on the right to add them as

well.

5. Add any additional charges, sales tax or discounts then click Save, Save and close, Save and

new, Save and send or Save and share link.

() Invoice

1 linksd Tima Charge

Customer (7 Customar smail (3) CofBec

Billing addires: Torms () Invoics data Dus date
2130 06/18/202
Togs @
# PRODUCT/SERVICE (1) DESCRIPTION
1 DesignDesig Custom O
Add | Claar all i Add sublotal

Message on statement

2 Toko atour

$375.00

ary RATE AMOUNT TAX

Subtotal

Taxable subtotal $0.00

v B%

Discount parcent  +

Total

Balance due

8 (@D help X

<

BALANCE DUE

@ i
o

$375.00

$0.00

$375.00

$375.00

Cancel Clear ake 9 s
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Enter Transactions from the Sales Transactions Page (Sales Center)

@
o Step by Step: Create an Invoice

1. Click Sales - All Sales from the left navigation bar.

wrturk

ab qu|ckbook5 = Sample Company

+ New Overview All Sales Invoices Payment Links Customers Products and Services

Salés Transactions

Banking

Unbilled Last 365 Days Unpeid Last 365 Days

$375 $1,526

Sales

1 UNBILLED ACTIVITY 10 OVERDUE

Projects

Payroll

Last 365 Days
I Batch actions

Time

2. This opens the Sales Transactions or Sales Center. Under the Action column (1), there are
suggested next steps. You can filter the Money Bar (2) here the same way you can in the
Customer Center. You can also create a New Transaction at the top right of the screen. Click
New transaction = Invoice (3).

= Sample Company B wepens @QHae Q O & ol

Overview All Sales Invoices Payment Links Customers Products and Services
Sales Transactions Import Transactions v
Invoice
Unbilled Lest 365 Days Unpaid Last 365 Days Paid
Payment
$0 $375 $3,136 Esimate
0 ESTIMATE 1 UNBILLED ACTVITY 12 PAID LAST 30 DAYS 3
Payment Link ({5

Sales Receipt

CreditMeme

P
T Batch actions v Time Activity

1-67 of 67

DATE v TYPE NO. CUSTOMER MEMO DUE DATE BALANCE TOTAL STATUS ACTION

05/19/2021  Invoice 1039 Amy's Bird Sanctuary 06/18/2021 $375.00 $375.00 Open Receive payment w

05/19/2021  Invsice 1038 Diego Rodrigusz 06/18/2021 $2,250.00 $2,250.00 Open Receive payment v

05/19/2021 = Estimate 1001 Diego Redriguez 05/19/2021 $0.00 §2,250.00 Closed Print »

04/23/2021  Invoice 1037 Sonnenschein Family St 05/23/2021 $362.07 $362.07  Open Receive payment v

O 000
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3. Create a new invoice for Video Games by Dan. When you enter the customer name, QuickBooks
Online opens a drawer on the right that shows time or expense activities that have been marked
billable or any delayed charges or credits for this customer. You can easily add them to the
invoice. The difference between creating the invoice from here (in the Sales Center) vs. creating
it from the Action column for that customer or activity, is in the Sales Center you have a choice of
what you are adding (you can click Add for each item you wish to add or you can click Add all if

you wish to add them all); if you create an invoice from the Action column, it automatically puts
the unbilled activity on the invoice.

& Invoice

Customer ()

Billing address

Dan Wilks
Vi N

Customer email ()

Video Gemes by Dan v | | videogemes@in
] Sentver G

Terms (@)

Net30

# PRODUCT/SERVICE (1)

1

2

Addlines | | Clearalilines | [ Add subtotal

Messaga on invoice

Massaga on stateme

Thenk you for your business and heve & greet day!

nt

Invoica dat

Creat

05/19/2021

Ce/Bec

Duedata

e recurring inveice

DESCRIPTION

06/18/2021

Manage tags

ary AMOUNT

Subtotal

Taxabla subtotal

Discount percent ¥

Total

Balance due

Print or Preview Customize

Make recurring

BALANCE DUE

$0.00

TAX

=]

=

$0.00

$0.00

$0.00

$0.00

BTskeatour 63 (@) Help X

Add to Invoice

Fiter by

All dates v

==

Charge #1

Apr20

$300.00

Installation of landscape
esign

Add Open

Charge #1

Apr20

575.00

Weekly Gardening Service

Add
e ————

Open
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4. Invoice just for the installation by clicking Add (and you can collapse the drawer by clicking the
sideways caret if you want, as indicated in the previous screen capture), and you'll see there is a
hyperlink to 1 linked Charge in the top left portion of the invoice. Then Save and close.

S, s

& Invoice DTskeatorr 85 (@) Help X
inked Charge I4
Customer (2) Customer email () Co/Bee BALANCE DUE

Video Games by Dan ¥ | | videogames@intuit.com $300 00
.
[ serciner ®

Billing address Torms () Invoice date Due date
Dan Wilks Net30 v | | osr19/2021 06/18/2021
Video Games by Den

202 Main St Create recurring invoics
Tucson, AZ 85704

Togs @ Menege tags
# | PRODUCT/SERVICE (D) DESCRIPTION ary RATE AMOUNT TAX
1 Landscaping:installation Installation of landscape design 6 50 300.00 red i
2 [}
Addlines | | Clearalllines | [ Add subtotal Subtotal $300.00
Msssaga on invoica Taxabls subtotal $0.00
Thank you for your business snd have a grest day!
hd 0.00
"
Discount percent ¥ $0.00
Message on statement Total $300.00
Balance due $300.00

Frintor Preview | Makerecurring | Customize Save Save and close

5. This brings you back to the Sales Transactions list. To clear any filter resulting from the Money
Bar selection, so you can see all the transactions, click Clear filter / View all at the top of the
table, if it is visible. Note this table is sorted by date. You can sort by any column header by
clicking that column'’s header (clicking sorts by that parameter; clicking twice sorts it in reverse
order).

Overview All Sales Invoices Payment Links Customers Products and Services

Sales Transactions

Unbilled Last 385 Days Unpeid Last 365 Days

Paid
$0 $75 $1,526 $3.136
0 ESTIMATE 1 UNBILLED ACTVITY 12 PAID LAST 30 DAYS

~
Last 365 Days Invoices X Overdue > Clear filter / View al
T Batch actions v

1-10of 10
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If you don't see the columns you need, click the grid gear icon above the Action column and
choose the columns you want to display. Then click the grid gear icon again to make that list of
columns disappear.

Overview All Sales Invoices Payment Links Customers Products and Services
Sales Transactions Import Transactions v
Unbilled Last 365 Days Unpsid Last 365 Days Paid
$0 §75 $1,526 53,136
O ESTIMATE 1 UNBILLED ACTIVITY 10 OVERDUE 23 OPEH CES 12 PAID LAST 30 DAYS
AR
~
L3650
I Batch actions v f :( \
Columns
[] oate~ TYPE NO.  CUSTOMER MEMO DUE DATE BALANCE TOTAL STATUS [ Mathod
[] 0511972021 Invoice 1040 Video Games by Dsn 06/18/2021 5300.00 $300.00 Open [ source
[ Aging
[] 05/19/2021  Invoice 1039 Amy's Bird Senctery 06/18/2021 5375.00 $375.00 Open [ Lest delivered
. . [ email
[] 0511972021 Inveice 1038 Diego Rodriguez 06/18/2021 $2,250.00 $2,250.00  Open
[] attachments
[ 0511972021 Estimete 1001  Diego Rodriguez 05/19/2021 50.00 $2,250.00  Closed Type
~ Show More
[ 04232021 | Invoice 1037 Sonmenschein Family St 05/23/2021 535207 $362.07  Open
Rows
[ o04r232021  Invoice 1036 Freemen Sporting Goo 05/23/2021 5477.50 $477.50 Open 150 v
[] o4r232021  Peymem Freeman Sporting Goo 04/23/2021 $0.00 -$387.00 Closed \ [ compect /
[ oar232021  Peymene Cool Cers 04/23/2021 $0.00 $1,675.52  Closed

O

0,

Step by Step: Receive Payment

The next step is to receive payment. Dan sent us a check for $300. Click Receive payment next

to his name.

Overview All 5ales Invoices

Sales Transactions

$0

0 ESTIMATE

Batch actions »
s

Payment Links Customers

Unbilled Last 365 Days

$75

1 UNBILLED ACTVITY

Products and Services

Unpaid Last 365 Days

=
$1,526 s
|| tooveroue

Paid

e
1-68 of 68
(]| oate~ TYPE NO. CUSTOMER MEMO DUE DATE BALANCE TOTAL STATUS
D 05/19/2021  Invoice 1040 Videe Games by Dan 06/18/2021 $300.00 $300.00 Open
[[] os/192021  invoice 1039 Amy's Bird Sancwary 06/18/2021 $375.00 $375.00 Open Receive payment w
Ll 05022021 10 DicaoRadn 0522001 225000 2250000 Receive payment
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2. Alist of Outstanding Transactions shows up for this customer with the invoice being paid
checked. You can deposit to Undeposited Funds or directly into a bank account. In a real
company, if you're signed up for QuickBooks Payments, you would see a box to check to process
a credit card here. You'll learn more about payments in Module 5. Specify the Payment date, the
Payment method, the Reference no. (check number), choose Undeposited Funds -> Save and

close.
(S Receive Payment @ Help | X
Customer AMOUNT RECEIVED
Video Gemes by Dan v Find by invoice no. $3°0-00

Payment date
05/20/2021
P d Refaranca no. Dopositto
Check 1234 ndeposited Funds | ¥

Outstanding Transactions

Filter > A
O DESCRIPTION DUE DATE ORIGINAL AMOUNT OPEN BALANCE PAYMENT
nusice #1040 (05/19/2021) 06/18/2021 300.00 300.00 300.00
110f1

Amount to Apply $300.00
Amount to Cradit 50.00

( Clear Payment )

From the Sales Transactions page you can enter transactions contextually based on the currently
listed transaction (click the drop-down in the Action column for that transaction), or you can create
new sales transactions (click the New transaction drop-down at the top of the page).
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Enter Transactions from +New

If you have the expanded view of +New open, you can see a list of sales type transactions under the
Customers column.

)
CUSTOMERS VENDORS EMPLOYEES OTHER
Invoice Expenze Payroll # Bank deposit
Receive payment Check Time entry Transfer
Estimate Bill Journal entry
Credit memo Pay bills Statement
Sales receipt Purchase order Inventory gty adjustment
Refund receipt Vendor credit Pay down credit card
Delaysd credit Credit card credit
Delayed charge Print checks
——
Show less
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0

O

Step by Step: Enter a Delayed Charge

To open +New, click the +New sign at the top of the left navigation bar in QuickBooks; if you
don't see the expanded view, click Show more.

Click Delayed Charge. A delayed charge is a non-posting transaction; you're telling QuickBooks

Topic 1: Sales and Revenue Transactions

Online you will need to invoice a customer for something in the future. Let's say you are a
landscaping service and do gardening for multiple customers. Every day you record where you
gardened that day, but you invoice only once a month. You can record that activity in
QuickBooks Online as a delayed charge and, at month end, create an invoice.

CUSTOMERS
Invoice

Receive payment
Estimate

Credit memo
Sales recesipt
Refund receipt

Delayed credit

Delayed charge

VENDORS
Expensze

Check

Bill

Pay bills
Furchase order
Vendor credit
Credit card credit

Print checks

EMPLOYEES
Payroll #

Time entry

OTHER

Bank deposit

Transfer

Journal entry

Statement

Inventory gty adjustment

Pay down credit card

Show less
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3. Enter Amy’s Bird Sanctuary. In the Date field type a w to select the beginning of the currently
displayed week. Enter Gardening under the Product/Service column. Enter 4 under the QTY
(Quantity) column and $35 under the Rate column. Click Save and new.

=
(& Delayed Charge & @ rp X
Customer Moy
JR— - $140.00
Delayad Charga Data
05/16/2021
Togs @ Menage tags
#  PRODUCT/SERVICE DESCRIPTION ary RATE AMOUNT TAX
1 Lendscaping:Gardening Weekly Gerdening Service 4 35 120.00 [i]
2 i
Addlines | | Clearalllines Total $140.00
Memo
@ Attachments  Masimum sz 20M2
Show existing
Prvacy
Cancel Clear Make recurring Save andnew v
{
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4. Enter Amy’s Bird Sanctuary. In the Date field, type a k and +. K brings you to the end of the
currently-displayed week and the + advances a day, which brings you to the beginning of next
week. Enter Gardening under the Product/Service column. (Some of this might be there already,
if the Automation preferences are set to Pre-fill forms with previously entered content in Account
and Settings.) Enter 3 under the QTY column and $35 under the Rate column. Click Save and

-
(& Delayed Charge 8 @Hep X
Customar AMOUNT
JeP— . $105.00
Delayed Cherge Date
05/23/2021
Togs @ Menage tags
# PRODUCT/SERVICE DESCRIPTION ary RATE AMOUNT TAX
1 Lendscaping:Gardening Weskly Gardening Service 3 35 105.00 [i}
2 [}
Addlines | [ Clearalllines Total $105.00
Memo
@ Attachments  Mssimum omMB
Show existing
Priv

Make recurring Saveandnew v
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@
o Step by Step: Create an Invoice from +New

1. From +New choose Invoice.

CUSTOMERS VENDORS EMPLOYEES OTHER
( Invoice ] Expense Payroll # Bank deposit
: Receive payment Check Time entry Transfer
Estimate Bill Journal entry
Credit memo Pay bills Statement
Sales receipt Purchase order Inventory gty adjustment
Refund receipt Vendor credit Pay down credit card
Delayed credit Credit card credit
Delayed chargs Frint checks
Show less

2. Enter Amy’s Bird Sanctuary. As soon as you enter the customer name, if there are any unbilled
(delayed) charges (or credits) or unbilled time (or expenses), a drawer opens on the right so you
can easily add them to the invoice.

(% Invoice Brsksarour @3 @ Htp X
Customer (1) Co/Bec » Add to Invoice
BALANCE DUE : o
amy's Bird Sanctusry - .
$0.00 Fner oy
All dates v
Billing addrass Terms (3} Inwoics date Dus dats
Net 30 v 05/23/202 06/22/202
R Charge #1
Tags @ lanage ugs May 16

& PRODUCT/SERVICE () DESCRIPTION ary RATE AMOUNT  Tax
i)
(]
Add lines Claar all lines ‘Add sublotal Subtotal 50.00
Toxable subtotsl $0.00
ve o gress day Caliornia . 8%
i
Discount parcant  * 50.00
Wessags on statemant Total $0.00
Balance due $0.00
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3. Click Add all then Save and close.

& Invoice DTskeatorr 8 () Help XK

2 linksd transactions
Customer (D) Customer email (7) Cc/Bec BALANCE DUE

Amy's Bird Senctuary v | | Birds@inwitcom $245 oo
.
[ sencizer @

Billing address Terms () Invoice date Due dste
Amy Lauterbach Net 30 v | | 05232021 06r22/2021
Amy's Bird Sanctuery
4581 Finch st Creste recurring i

Bayshore, CA 94326

Tags @ Manage tags
# PRODUCT/SERVICE (D DESCRIPTION arr RATE AMOUNT TAX
1 Lendsceping:Gerdening Weskly Gardening Service 4 35 140.00 @ o
2 Landscaping:Gardening Weekly Gardening Service 3 35 105.00 @ o
E] [}
Addlines | | Clearalllines | | Add subtotal Subtotal $245.00
Message on invoice Texable subtotal $0.00
Thank you for your business and have a great day! J— e oo
1
Discount percent ¥ $0.00
Message on statement Total $245.00
Balance due $245.00
Make recurring ustomi; Save Save and close

Cancel Clear
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@
2! Step by Step: Recurring Transactions

If you have monthly recurring charges and you don't want to have to remember to enter them,
QuickBooks Online can create an invoice automatically and email it to your customers. Use the
Recurring Transactions feature. Most transactions (sales, purchases and journal entries) can be made
recurring.

1. From +New click Invoice.

CUSTOMERS VENDORS EMPLOYEES OTHER
Invoice ] Expense Payroll # Bank deposit
Receive payment Check Time entry Transfer
Estimate Bill Journal entry
Credit memo Pay bills Statement
Sales receipt Purchase order Inventory gty adjustment
Refund receipt Vendor credit Pay down credit card
Delayed credit Credit card credit
Delayed charge Print checks
Show less
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2. Type Bill's Windsurf Shop and choose Pest Control under Product/Service. Leave the quantity at
1 and the rate at $35. At the bottom of the screen click Make recurring.

' Invoice

B Teke = tour

8 @ Hlp X

@ Attachments

Meximum size: 20MB

Print or Preview

Make recurring

Billing addrass Terms () Invoica date Dus dats
Bill Lucchini Net 30 05/23/2021 0612272021
Bill's Windsurf Shop
12 Gcean Or Crasta racurring imvoics
Holf Moon Bay, CA 94213
Tags @ Manage tags
# _PRODUCT/SERVICE (9 DESCRIPTION ary RATE AMOUNT TAx
—
(+] l 1| Pest Control:Pest Control | v | [PestConol Services 1 35 35.00 O [i]
2 [i]
1 y
Addlines | [ Clearslllines | [ Add subtotal Subtotal $35.00
Messago on invoice Taxable subtotal $0.00
Thank you for your business and have a great day! o
14
Discount percent ¥ $0.00
Massage on statemant Total 535.00
Balance due $35.00

Save and close

QuickBooks Online 2021 Client Training

38



Course 3 - Record Transactions in QuickBooks Online

Topic 1: Sales and Revenue Transactions

3. This opens a screen where you can create a recurring invoice template. You can name the
template, say whether you want it automatically entered, choose to send an email automatically
and, if scheduled, set up the schedule. Click Save template.

' Invoice

Recurring Invoice

Half Moon Bay, CA 94213

Tags @

# PRODUCT/SERVICE ()
1 Pest Control:Pest Contral

2

Addlines | | Clearalllines | | Add subtotal

Massage on invoica

Thank you far your business and have a great day!

Cancel Clear

Template nama Type
Bill's Windsu Scheduled v | Create days in advance
Customer Email
8ill's Windsurf Shoo v Surf@Intuit. com
CefBee

Interval Start date
Monthly v | on| dey = | 1a v |ofevery 1 | month(s)

Torm:

Net 30 -

Options
[ | Automatically send emails
Print later

[ |Include unbilled charges

End

None v

Menage tags

DESCRIPTION ary

Pest Control Services 1

Customize

35

B @wr X

AMOUNT TAX

35.00

a

=]

Subtotal $35.00

Taxable subtotal $0.00

Save template

You have a lot of flexibility when creating a template. Experiment with it in the sample file. Note that
if you have an already-recorded transaction and want to make it recurring, you can open it up and
click Make recurring at the bottom of the screen. Remember that most transactions can be made

recurring.
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@
{@% Step by Step: Recurring Transaction List

Topic 1: Sales and Revenue Transactions

1. To see a list of recurring transactions, click the gear icon and open Recurring Transactions

under Lists.

YOUR COMPANY LISTS
Account and settings Al lists

Manage users Products and services

Custom form styles

Recurring transactions {h]

Chart of accounts Attachments
CQuickBooks labs Custom fields
Tags

You're viewing QuickBooks in Accountant view. Learn more

TOOLS

Order checks &

Import data

Import desktop data

Export data
Reconcile
Budgeting
Audit log

SmartLook

Resolution center

PROFILE
Feedback

Privacy

Switch to Business view

2. From here you can add new templates, edit an existing template, use an existing template,
duplicate it (a good starting point for a new template) or delete it.

Recurring Transactions
< Al Lists
[ Fker by nam | (Criter v Y2
TEMPLATE NAME v TYPE TXNTYPE INTERVAL
Telzphons il Scheduled il Every Month
Morthly Bulding Lesse Scheduled il Every Month
Bill's Windsurf Shop Scheduled Invoice Every Month

PREVIOUS DATE

NEXT DATE

05/08/2021

05/08/2021

06/01/2021

CUSTOMER/VENDOR

Cal Telephene

Hall Froperties

8ill's Windsurf Shop

-
i |-

AMOUNT ACTION
74.36

200.00

Duplicete

35.00 Delete
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Topic 2: Expense and Purchase Transactions

Whenever you set up a new area of QuickBooks, you need to review the Account and Settings
related to that area. Before you go into the Account and Settings, you need to make sure you
understand the different types of expense and purchase transactions.

@ Bill is a transaction you enter when you receive a bill from a vendor but want to pay it later. A bill
will increase accounts payable and generally increase expenses. This is available in Essentials,
Plus and Advanced only.

® Expense is a way to enter cash, check or credit card purchases all in one window. (Note that you
cannot print checks that were entered from the Expense window.)

® Checks are a way to enter transactions that reduce your bank account. You can assign check
numbers for manual checks or checks that have already been printed. Or you can set checks to
print later and print them when you're ready.

® Bill payment is a transaction used to pay the bills entered. A bill payment reduces accounts
payable and can be from a bank or credit card account. This is available in Essentials, Plus and

Advanced only.

® Purchase order is a non-posting transaction used to tell a vendor you want to order goods or
services. This is available in Plus and Advanced only.

® Vendor creditis used to record either a refund or return from a vendor that reduces accounts
payable. This is available in Essentials, Plus and Advanced only.

@® Credit card credit is a transaction that records a credit card refund from a vendor

All these transactions relate to monies going out. Most of these transactions can be launched from
more than one access point, whereas others can be launched only from one.
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APPROPRIATE EXPENSE-RELATED SETTINGS

Account and Settings

Click the gear icon and choose Account and Settings under Your Company.

Custom form styles

Recurring transactions

You're viewing QuickBooks in Accountant view. Learn more

YOUR COMPANY LISTS TOOLS PROFILE
[ Account and settings Al lists Order checks & Feedback
Manage uzers Froducts and zervices Import data Privacy

Import desktop data

Chart of accounts Attachments Export data
QuickBooks labs Custom fields Reconcile
Tags Budgeting
Audit log
SmartLook

Reszolution center

Switch to Business view

There are several tabs down the left side to set the preferences you want to use with the company
file. There is a separate tab for Expenses, but there are also expense-related settings included in the

Advanced tab.

QuickBooks Online 2021 Client Training

42



Course 3 - Record Transactions in QuickBooks Online Topic 2: Expense and Purchase Transactions
NOTE: In an actual QuickBooks Online company (as opposed to the test drive company below), you
would see more tabs down the left side.

Click Expenses. The Bills and expenses preferences allow you to use items on expense and
purchase forms (in addition to general ledger accounts), track purchases by customer and mark
them billable. You can also define the default bill payment terms.

There is also a place to set up the default email message sent with purchase orders.

NOTE: Your subscription level determines whether you can use some of these features. For example,
purchase orders can only be used in QuickBooks Online Plus and Advanced.

Account and Settings @ Hep X

Company
Bills and expenses Show Items table on expense and purchase forms @

U5 Show Tags field on expense and purchase forms @

Track expenses and items by customer @

ARAA

Sales

Make expenses and items billable (3

Expenses I [] Markup with a defaultrate of | 000 % @

Track billable expenses and items as income @

Advanced
® Inasingle account
In multiple accounts @

[ Charge ssles tax ®

Default bill payment terms -

(_Ganeel ‘m
Purchase orders Use purchase orders On Vi
Messages Default email message sentwith purchase orders 2

Privacy | Sacuriy | Terms of Servics
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Click Advanced. You'll see the same types of automation choices you saw with customers. Do you
want QuickBooks Online to apply bill payments automatically? Think about it before you turn it on.

Under the Other preferences section, it's a good idea to turn on the duplicate check and bill
warnings.

Account and Settings ® Help X
Company Automation Pre-fill forms with previously entered content On P
Automatically apply credits on
Usage
Automatically invoice unbilled activity Off

Automatically apply bill payments

Sales
Expenses Projects Organize all job-related activity in one place on P
Time tracking Add Service field to timesheets On 7
Make Single-Time Activity Billable to Customer on
Currency Home Currency United States Dollar i
Multicurrency off
Other preferences Date format MMddiyyy
Number format 12345600 v
Customer |abel Cusomers v | @
Warn if duplicate check number is used [ @)
Warn me when | enter  bill number that's already «©
been used for that vendor
Warn if duplicate journal number is used
Sign me out if inactive for Thour ~

(_Cancel ‘m
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ALTERNATE ENTRY POINTS TO ENTER PURCHASING TRANSACTIONS

Vendor Center

The Vendor Center, accessed by selecting Expenses > Vendors in the left navigation bar, is a
dashboard for adding, editing and reviewing vendors with which your QuickBooks Online company
does business. The list of vendors can be printed or exported to Excel, and it can be sorted by
various parameters or filtered. In the far-right column, beside each vendor listing in the Vendor
Center, is a drop-down box from which to create transactions such as bills or checks, or to make a
vendor inactive. In addition, you can email vendors in batch by using the Batch Actions drop-down
list at the top of the list of vendors in the left corner. These emails can use your choice of web-based
email or email client.

Enter Transactions from the Vendor Center

@
o Step by Step: Create a Bill

1. Go to Action - Create bill for Bob's Burger Joint.

Xpense:

Unbilled Lsst 365 Days Unpaid Last 365 Daye Paid

anking
ales
$125 $848 $3,892
enses 1 PURCHASE ORDER AOVERDUE 21 PAID LAST 30 DAYS
rojects
-~

Batch actions v Q

VENDOR  / COMPANY PHONE EMAIL OPEN BALANCE ACTION

3
]
[] Bob's Burger Joint $0.00
]

Fooks by Bessie [ (650) 555-7745 Books@Intuit.com $0.00 Create bill v

[] Brosnahan Insurance Agen

(650) 555-9912 524123 Schadule payments v

— CalTelephone

Cioaiadill.

NOTE: Because of the setting Show items table on expense and purchase forms (in the Expenses tab
of Account and Settings), you have the choice to assign the detail portion of bills directly to one or
more accounts on the Chart of Accounts, or use one or more items from the Products and Services
list, or use a combination of the two functionalities.
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2. Assign a bill number 71234. Under Category details enter Advertising for $2,500, billable to
customer Amy's Bird Sanctuary.

> Ril
(5 Bill #1234 B @ rep X
Vondor BALANCE DUE
st o - $2,500.00
7 .
Mailing address Terms Bill date Due date ill
Bob's Burger Joint v 05/19/2021 05/19/2021 1234
Tags @ Menege tzgs
v Category details
# CATEGORY DESCRIPTION AMOUNT BILLABLE TAX CUSTOMER
(+) 1| Adverising 2,50000 [} Amy's Bird Sancvary -
2 [i]
Addlines | | Cloarall lines

3. Use the keyboard shortcut Ctrl + Alt + s to save this bill and open a new bill entry screen.

4. Enter a second bill #1333 for Bob'’s Burger Joint for Meals and Entertainment, $250 then Save
and close. (Because the Company Setting Pre-fill forms with previously entered content is turned
on (under Account and Settings > Advanced - Automation), you'll have to overwrite the
Advertising account that appears with Meals and Entertainment; you'll also have to change the
amount of the expense from $2,500 to $250.)

Notice that when you used your keyboard shortcut to save bill 1234, QuickBooks Online saved
the transaction and assumed you wanted to enter an additional transaction of the same type. But
QuickBooks Online does not assume you want to use the same vendor. Therefore, in this case
you needed to enter Bob's Burger Joint as the vendor in the second bill.

Now you see Bob's Burger Joint has $2,750 as an Open Balance in the Vendor Center:

Expenses  Vendors

Vendors

Unbilled Last 365 Days

Batch actions v

VENDOR 4 / COMPANY

Bob's Burger Joint

Brosnahan Insurance Agency

¥
0
0
[ BooksbyBessic (1
O
0

Cal Telephone

Unpaid Last 365 Days

PHONE

(650) 555-7745

(650) 555-9912

(650) 555-1616

$125 $3,598
1 PURCHASE ORDER 6 OVERDUE

( Prepare1099s | v )

Paid

$3,892
21 PAID LAST 20 DAYS

EMAIL OPEN BALANCE

$2,750.00

Books@Intuit.com $0.00

New vendor D

ACTION

Schodula paymants v
Creats bill »
Scheduls payments v

Craate bill v
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If you click the name Bob's Burger Joint in the Vendor Center, you will see the two open bills
adding up to $2,750. You can then make a payment by clicking Mark as paid in the drop-down
of the Action column in the far right next to one of the bills. If you want to pay the second bill on
that same payment, you would be able to add the second bill to the payment transaction from
the Drawer that opens on the right of the Bill Payment screen. This is just one way to pay one or
more bills. (Don't pay these bills for now; we'll pay them in the next section.)

However, you don't have to go down to the individual bill level to tell QuickBooks Online to pay
a vendor’s bills. There are many ways to pay bills in QuickBooks Online. We will cover bill
payments next.

$2,750.00
I $2,750.00
OVERDUE
TransactionList |  Vendor Details
1 (sateh sctions + ) (CFiter + )
1-50f5
[] paE~ TYPE NO. PAYEE CATEGORY MEMO TOTAL  ACTION
~
[] osrter2021 il 1333 | Bob's Burger Joint Meals and Entenainment A 525000 Schedule pay.. (3]
Mark as paid
[] osrer2021 il 1234 Bob's Burger Joint Advertising - $2,500.00 dn
View/Edit )
[ 0272912021  Credit Card Expanse Bob's Burger Joint Meals and Entertainment v | Bought lunch for crew 102 $18.97 Copy
Delete
[[] oa20/2021 = Cash Expense Bob's Burger Joint Mesls and Entertainment - 5286
[[] o0ar15/2021 = Cash Expense Bob's Burger Joint Mesls and Enterainment - -55.66
Totel $2,750.45
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@
o Step by Step: Pay Bills

1. Go back to the Vendor Center if you have left it. From the Action column, click Make payment in
the drop-down for Bob’s Burger Joint.

Expenses  Vendors

Vendors

) (D

Unbilled Last 365 Days Unpaid Last 365 Days Paid

$125 $3,598 $3,892
1 PURCHASE ORDER 6 OVERDUE 21 PAID LAST 30 DAYS

Batch actions v Q,

[] veNDOR + / company PHONE EMAIL OPEN BALANCE ACTION
[] Bob's Burger Joint $2,750.00 Schedule payments (7]
Make payment M
[l Books by Bessie [] (650) 555-7745 Books@Intuit com 30.00 —
Create expense
Brosnahan Insurance Agen:
O° gency (650) 555-9912 524123 Schodula payments v

Brosnahan Insurance Agency

2. QuickBooks Online opens the Bill Payment screen with that vendor’s outstanding bills listed and
already checked for you to pay. At the top of the screen you can choose to pay via a bank
account or credit card. Specify the date of payment and a reference number if possible.

(> Bill Payment #May20Pmt

AMOUNT PAID
Payoo. Bank/Credit account
N= 515772 $2,250.00
* Add new -
Checking Bank
Mailing address Paym Ref no
Savings Bank
Bob's Burger Joint 05/ May20Pm:
Mastercard Credit Gard
Visa Credit Card
Inventory Asset Other Gurrent Asssts
Amount
Prepaid Expenses  Other Current Assets 2,250.00
. . Uncategorized Asset Other Current Assets
OQutstanding Transactions
———— Undeposited Funds  Other Current Assets
Filter > 2
DESCRIPTION DUE DATE ORIGINAL AMOUNT OPEN BALANCE PAYMENT
Bill #1234 (05/19/2021) 05/19/2021 2,500.00 2,500.00 2,000.00
Bill # 1333 (05/19/2021) 05/19/2021 250.00 250,00 250.00
us 1-20f2
Amount to Apply $2,250.00
Amount to Credit $0.00

@ Help )

( Clear Payment )

Cancel Clear Save and close
3. Ifyou are not paying all the outstanding bills, uncheck the ones you aren’t paying.
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4. If you are partially paying one or more of the bills, overwrite the amount you are paying in the
Payment box for each partially-paid bill.

5. Atthe bottom of the screen click Save and close.

As with the Customer Center, you can click the vendor name and get a list of transactions you can
act upon, or create new transactions by clicking the New transaction button at the top right.

New transaction v \

U

Bob's Burger Joint CEdi )

Time Activity
Bil

Expsnse
Check
Purchase order

Transaction List Vendor Details Vendor Credit

‘ Psy down credit card ‘

J:C Batch actions ) ( Filter w )

1-6of &
[] pate~ TYPE NO. PAYEE CATEGORY MEMO TOTAL ACTION
[} 05202021  Bill Payment (Credit Card) May... = Bob's Burger Joint -$2,250.00
[ osrerz021 il 1333 | Bob's Burger Joint Maals and Entsrsinment | $250.00 View/Edit ¥
[ osr19r2021 il 1234 Bob's Burger Joint Advertising - $2,50000 Schedule pay...
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Enter Transactions - Expenses

If you click Expenses - Expenses in the left-hand navigation bar, QuickBooks Online opens a list of
the last 365 days of Expense Transactions (all kinds of money-out transactions), regardless of vendor
or payee. This screen can be filtered to modify the view. You can drill down on any transaction. You
can also enter a new transaction or print checks.

@
o Step by Step: Enter an Expense Type of Transaction

1. From the New Transaction drop-down menu, choose Expense. To recap: an expense transaction
(a specific transaction type under the broad Expense transactions category, including
transactions such as bills or checks) allows you to either reduce your bank account (including
cash) or increase your credit card payable for a purchase made for the company. An expense
transaction is a good transaction type to use when inputting a backlog of receipts that have been
collected but not sorted by payment type. With the expense transaction, there is no need to sort
the receipts first by credit card, check, other bank account or cash. Rather, you can enter them
using this one Expense screen by specifying the account (specified bank account, petty cash or a
specified credit card) at the top.

Expenses  Vendors

Expense Transactions Print Checks | v

Lo 368Dy
Batch actions v
r

DATE ~ TYPE NO. PAYEE CATEGORY MEMO TOTAI

\
New transaction v

Time Activity

sl

Expense
Check
Furchese order

Vendor Credit

i
&
3

05/20/2021  Bill Peyment (Credit Card) May...  Bob's Burger Joint Pay down credit card

05/19/2021  Bill 1333 Bob's Burger Joint Mesls and Entertsinment - $250.00 View/Edit v

%
8

/1972021  Bill 1234 Bob's Burger Joint Advertising - Schedule payment
05/19/2021  Credit Card Expense Automobile - $34.00

05/08/2021 | Credit Card Credit Checking v | Monthly Payment -$900.00

05/06/2021  Credit Card Expense Squesky Kleen Car Wash Automob:

e - 319,99

O 0000 Oon
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2. Enter an expense for the vendor Books by Bessie. It was paid with a MasterCard and was for
Dues & Subscriptions for $10. (It's also a good practice for tracking purposes to enter a
meaningful reference number, even if one is not supplied by the vendor.)

Payao

Books by Bessie

v Category details

# CATEGORY (9)

2

Addlines | | Clearalllines

(& Expense #May202021

Payment account ()

+ Add new
Checking Bank
Payment date.
Savings Bank
05/20/2021
Mastercard Credit Card
Tags @ Visa Credit Card

Inventory Asset Other Current Assets
Prepaid Expenses  Other Current Assets

Uncategorized Asset Other Current Assets

Undeposited Funds  Other Current Assets

1 Dues & Subscriptions

Raf no.

May202021

Menage tags

iCRIPTION

BTekeatour ) () Help X

AMOUNT

$10.00

AMOUNT BILLABLE () TAX CUSTOMER (%)

10.00

=13

=3

3. Atthe bottom of your screen click Save and new.

4. Enter a transaction for Computers by Jenni. It was paid out of Checking with manual check #32
on the same date. It was for Commissions and Fees for $100. Save and close.

(X} Expense #32

D Takeatowr & (D Help\z

Payee Paymant account (9 AMOUNT
fS——— o [ = . $100.00
Payment date Payment method Ref no.
05/20/2021 Cheek v 22
Tags @ Manage tags
v Category details
# CATEGORY () DESCRIPTION AMOUNT BILLABLE (3) TAX CUSTOMER (3)
1 Commissions & fees 100.00 i
2 [}
Addlines | | Clearalllines
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On the Expense Transactions page both expenses appear, but one affected the bank account
(Checking) and the other a credit card account (MasterCard). If you are entering all checks, use the
Check feature rather than the Expense transaction. Remember, the Check feature allows you to print
checks while the Expense transaction does not.

Expenses  Vendors
Expense Transactions w: Print Checks v:‘
PR
:
1-68 of 68

[] paE~ TYPE NO. PAYEE CATEGORY MEMO TOTAL ACTION

D 05/20/2021  Expenss 32 Computers by Jenni Commissions & fees - $100.00 View/Edit v

[ osr20/2021  Expense May202021  Books by Bessie Dues & Subscriptions - $10.00 view/Edit v

[ osr20/2021  Bill Payment (Credit Card) Mey20Pmt  Bob's Burger Joint -§2,250.00

[] osrerzo21 sl 1333 Bob's Burger Joint Meels and Enterginment - $250.00 View/Edit v

[] osrerz021 sl 1234 Bob's Burger Joint Advertising - $2,500.00  Schedule payment v

[ 051972021 Credit Card Expense Autemobile - 534.00

[ os/oer2021  Credit Card Credi Checking v | Monthly Payment -$900.00
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Enter Transactions from +New

Previously you learned how to pay one or more bills from the Vendor Center, but this would allow

Topic 2: Expense and Purchase Transactions

you to pay only one vendor at a time. If you want to pay bills from multiple vendors at one time, you
need to access Pay Bills from +New at the top of the left navigation bar.

<

o Step by Step: Pay Multiple Bills

1. Click +New then, under Vendors, select Pay Bills.

CUSTOMERS VENDORS EMPLOYEES OTHER
Invoice Expense Payroll # Bank deposit
Receive payment Check Single time activity Transfer
Estimate Bill Weekly timesheet Journal entry
Credit memo Pay bills ) Statement

U
Purchase order

Sales receipt Inventory gty adjustment

Refund receipt Vendor credit Pay down credit card

Delayed credit Credit card credit
Delayed charge Frint checks

Show less

2. Select Checking as the Payment account.

(% Pay Bills
Payment account

| hedking H

+ addnaw

nisl

Checking Bank
Savings Bank |-
Mastercard  Credit Card

Yisa Credit Card
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3. Enter the Payment date (this method assumes you are paying all the selected bills on the same
date) and check the box for Print Later (instead of specifying a starting check no. for manual
checks). You can sort the list by clicking the column headers as in the Vendor and Customer
centers. This allows you to sort how you want to see the bills listed. You can also filter the list.
Select which bills to pay by placing a checkmark in the far-left column next to the bill(s). If you are
going to pay less than the open balance on a bill, enter that amount in the Payment column. The
footer area tells you how much you have in the bank account after making these payments. Click
Save and print.

(S Pay Bills

Paymant account.

Payment date

Checking + | Balance 31,101.00 05/20/2021

Starting check no.

To print Print later

Bob's Burger Joint

Brosnahan Insurance Agency

Diego's Road Warrior Badyshop

PGAE

Robertson & Associstes

Clelo ol &)

3 bills selected

Norton Lumber and Building Materi

REFNO.

1234

DUEDATE
05/19/2021 €@
04/27/2021 €
05/22/2021

04/24/2021 €
04/09/2021 @

04/24/2021 €@

Total payment (USD) 817.67

OPEN BALANCE

$500.00

$241.23

$755.00

$205.00

$86.44

§215.00

$827.67

CREDIT APPLIED PAYMENT
490.00
24123
86.44
$0.00 $817.67
Current account balance  $1,101.00
Total payment -5817.67
New account balance 5263.33

@ X
TOTAL PAYMENT AMOUNT
$817.67
6 open bills, 5 overdue €
TOTALAMOUNT
$490.00
$241.23
50,00
$0.00
S86.44
$0.00
$817.67
1-60f 6
Save
Save and close I:

Cancel Schedule paymentsonline v
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When you click Save and print QuickBooks Online will give you a list of bills paid as well as print the
bill payment checks. (You may see a Print Checks setup screen first if you haven't printed checks
before.)

Print Checks X

Checking ~ | Balance $283.33 3 checks selected $817.67 ( Addcheck )

Starting check no.

Remove from list Sortby Date / Order crested v Show all checks v 1001

I o
DATE TYPE PAYEE AMOUNT

05/20/2021 Bill Payment (Check) Bob's Burger Joint $490.00

05/20/2021 Bill Payment (Check) Brosnahan Insurance Agency $241.23

05/20/2021 Bill Payment (Check) PGEE $86.44

Print setup Order checks Preview and print

If you chose the payment method of Printed Check but decided not to print them immediately from
this screen, that's fine. These checks can be batch printed later. You'll learn about that shortly.
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@
o Step by Step: Create a Check (write a check to pay a bill)

1. Click +New then, under Vendors, select Check.

CUSTOMERS VENDORS EMPLOYEES OTHER
Invoice Expense Payroll # Bank deposit
Recsive payment Check Jh,] Single time activity Transfer
Estimate Bill Weekly timeshest Journal entry
Credit memo Pay bills Statement
Sales receipt Purchase order Inventory gty adjustment
Refund receipt Vendor credit Pay down credit card
Delayed credit Credit card credit
Delayed charge Print checks
Show less

2. Enter the vendor Diego’s Road Warrior Bodyshop. If you enter a vendor name and there is an
outstanding bill related to that vendor, a drawer opens on the right-hand side of the page which
allows you to add the bill to the check. The accounting effect is to decrease the bank account
balance and decrease accounts payable. This feature will help prevent you from writing a check
for a bill already entered and posting it to an expense account, thereby double-counting the
expense and never clearing the payables.
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3. Click Add to add the bill to the check. This changes the transaction type from Check to Bill
Payment. (Note Check #To print changed to Bill Payment #To print in the top left corner of the
transaction.) If desired, remove the checkmark in the box next to Print later to assign a manual

or already-assigned check number. Click Save and close.

S =
"f‘_—,' Check #To prlntl & @ Help| X
Payes Bank Account AMOUNT > Add to Check
F————en o | pre | e 2852 $0.00
Add all
Mailing address Payment date Checkno.
Diego's Road Werrior Badyshop | | 05/25/2021 To print
[+#] Print later
Togs @ Manage tags
v Category details
# CATEGORY DESCRIPTION AMOUNT BILLABLE TAX  CUSTOMER
1 @
2 ]
Addlines | [ Clearall lines
S e A
(% Bill Payment #To print ] 8 @ Hep X
Payeo Bank Account AMOUNT PAID
Segm font WSty | < | [chodies o . $755.00
Mailing addrass Paymnt deta Chack no.
Diego's Road Warrior Bodyshop | | 06/25/2021 To print
[+/]Print later
Tegs D Manege tags
Amount
755.00
Outstanding Transactions
Filter > A
DESCRIPTION DUEDATE ORIGINAL AMOUNT OPEN BALANCE PAYMENT
Bill (04/22/2021) 05/22/2021 755.00 755.00 755.00
110f1
Amount to Apply $755.00
Amountto Cradit 50.00
(' ClearPayment )
Memo
Cancel Clear Print check Order checks More Saveandclose v

If this check wasn't intended to pay an outstanding bill, don't add anything from the drawer, even if
there is a bill there, and enter the account or item details in the body of the check.
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@
o Step by Step: Print Checks in Batch

1. Click +New then, under Vendors, select Print Checks.

CUSTOMERS VENDORS EMPLOYEES OTHER
Invoice Expense Payroll # Bank deposit
Receive payment Check Single time activity Transfer
Estimate Bill Weekly timesheet Journal entry
Credit memo Pay bills Statement
Sales recsipt Purchase order Inventory gty adjustment
Refund receipt Vendor credit Pay down credit card
Delayed credit Credit card credit
Delayed charge Print checks

&

Show less

2. The first time you click Print Checks, you must make sure your checks align correctly. Once you
have done that, all checks marked to be printed later will appear in the Print Checks screen. You
can create a new check and add it to this Print Checks screen by clicking Add check in the top
right corner. (You can also return to the Print setup screen for proper alignment with your printer
by clicking Print setup at the bottom.)

l Print Checks l X

Checking ~ | Balance 3283.33 3 checks selected $817.67

(" Addcheck )

n

Starting check no.
Remove from list Sortby Dete / Order created ¥ Show all checks ¥ 1001

pATE TYPE PAYEE AMOUNT

3

Q™

5/20/2021 Bill Payment (Check) Bob's Burger Joint. $490.00

<

5/20/2021 Bill Payment (Check) Brosnahan Insurance Agency 524123

Y]

5/20/2021 Bill Payment (Check) PGRE s86.44

Cancel Print setup Order checks

Preview and print
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3. Place a checkmark in the box next to each check you wish to print, then select Preview and
Print. Before you do that, you need to make sure the starting check number is correct. Overwrite
it if it's not.

Banking

The Banking Center allows you to link your bank and credit card accounts to QuickBooks. Once that
is done, QuickBooks Online automatically downloads transactions nightly, though you can
download manually at any time by clicking Update in the upper right-hand corner.

@
o  Step by Step: Use the Banking Center

1. Select Banking > Banking from the left navigation bar.

qb a'ﬂ'mkbooks = Sample Company
App Transactions Rules Tags Receipts
Dashboard e Checking A
Banking
Checking Savings m Mastercard m
Sales
-$3,621.93 $200.00 $304.96
Bl BANK BALANCE BANK BALANCE Updated moments ago BANK BALANCE Updated moments ago
Projects $283.33 $800.00 1 $2,417.72 7
N QUICKBOOKS N QUICKBOOKS N QUICKBOOKS
Payroll
Time - .
For review (25) Categorized Excluded
Reports
Trres E Alldates W H+ All transactions (25) N ‘ ‘ Q, |
Mileage
Accounting
My Accountant [ ]  pate v DESCRIPTION PAYEE CATEGORY,
ol nesaninnns el Dls Dhmanic, Cmmlon o Pnnic
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2. Atthe top of the screen, the linked bank and credit card accounts are displayed as cards, as well
as the number of transactions that have been downloaded and need to be either entered or
matched. Although QuickBooks Online automatically downloads transactions nightly, you can

click Update to import the latest transactions at any time.

Banking  AppTransactions  Rules  Tags  Receipts
e Checking v
Checking m s Savings o
-$3,621.93 $200.00
BANK BALANCE Updated moments ago. BANK BALANCE Updated moments aga
$283.33 $800.00
N QUICKBOOKS 25 N QUICKBOOKS 1

Mastercard
$304.96
BANK BALANCE

$2,417.72

N QUICKBOOKS

El

Updated moments aga

7

< Link account | v) 3 Update

3. If your bank account does not connect to QuickBooks, choosing Upload from file in the drop-
down under Link account allows you to import CSV, QFX, QuickBooks Online or OFX formatted
files. You can also add new accounts to connect to QuickBooks Online by clicking Link account.

Banking  AppTransactions  Rules  Tags  Receipts

e Checking v

Checking m s Savings

El

-$3,621.93 $200.00
BANK BALANCE Updatad momen ago BANK BALANCE

283.33 800.00
s 25 5 1

N QUICKBOOKS N QUICKBOOKS

Updated momsntzage

Mastercard
$304.96
BANK BALANCE
$2,417.72

N QUICKBOOKS

E

Updated moman ago

7

PEO——
=
—

Uplosd from fle
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At the top of the screen click MasterCard to ensure you are reviewing that account. It will turn blue,
indicating that it's been highlighted.

4. Further down the page for Banking, there are three tabs: For Review, Categorized and Excluded:

® For Review - These are the newly downloaded transactions. They are the ones upon which
you need to take action.

® Categorized - These are transactions that have been matched or added from the For Review
tab. Although there are none in the sample file, once you start using the Banking Centerin a
live file, you will see many transactions listed there.

® Excluded - These are downloaded transactions you have decided not to enter into
QuickBooks. Typically, it is because they've already been entered and reconciled. Already-
reconciled transactions will not show up as a match. This typically occurs when you first use
the Banking Center.

Banking App Transactions Rules Tags Receipts

l Mastercard Vv

Checking m Savings w Mastercard

-$3,621.93 $200.00 $304.96

BANK BALANCE Updated moments age BANK BALANCE Updated moments ago BANK BALANCE Updated moments ago
$283.33 $800.00 $2,417.72

N QUICKBOCKS 25 N QUICKBOOKS 1 N QUICKBOOKS 7

For review (7) Categorized | Excluded )
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5. Inthe For Review tab, a list of downloaded transactions appears. The default is to show all
downloaded transactions, but you may see a drop-down choice indicating that only a subset of
all downloaded transactions is listed, for example Recognized transactions. Other filters are
available to help you view just the transactions you want to see. These are transactions that are
either matched from the bank download to entries already in QuickBooks Online, or QuickBooks
Online has guessed how you want to enter based on past transactions and rules. You might want
to take care of those first, just to clean up the list.

For review (7) Categorized | Excluded ) Take atour  Go to bank register

B Aldates vl Recognized (3) l I | Q ‘

S E &

For review (7) Categorized Excluded )

N |

5 Alldates v 4] Al transactions (7) L4 | Q,

« All transactions (7)

Recognized (3)

| | DATE w Matched RIPTION PAYEE
D 05/20/2021 Transferred on
[ osmomoz| Ruleepplied Lamination
Missing payee/customer
D 05/06/2021 sy Kleen Car Squesky Kleen Car Wash

\Unassigned /

6. Notice to the far right there is a printer icon and a grid gear icon. You can print the list of
transactions.

7. Click the grid gear icon. You can set preferences as to which columns you want to see and how
many rows you want to see in the Banking Center.

8. Ifit's not selected already, check Copy bank detail to memo.
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9. Click the grid gear icon again to make the list of options disappear.

& (@

Columns

[ ] Check No.

Fzyee

Groups

(3P Turn on grouping

Transaction details

D Show amounts in 1 column

[ ] Editable date field

Copy bank detail to memo ]

Show suggested rules

[ ] Show bank details

Enakle suggested categorization
Page Size

@ 50

() 75

() 100

() 150

() 300

This Copy bank detail to memo feature tells QuickBooks Online to copy the bank’s transaction
description to the Memo field automatically. The Memo field can show up on reports. It's also
useful for troubleshooting entries. You can edit the memo before adding a transaction to
QuickBooks.

The transactions can be sorted by any column parameter by clicking the column header
(clicking twice sorts it in reverse order). As you scroll down, notice in the Category or Match
column that QuickBooks Online has already matched several transactions.

QuickBooks Online 2021 Client Training 63



Course 3 - Record Transactions in QuickBooks Online Topic 2: Expense and Purchase Transactions

10. Click the column header Category or Match.

=
For review (7) Categorized Excluded ) Takeatour  Go to bank register
B Alldates v $th Al ransactions (7) v ‘ ‘ Q|
S B &
[] pate DESCRIPTION PAYEE [ CATEGORY OR MATCH & ] SPENT RECEIVED ACTION
[] | os06/2021 Squeaky Kleen Car Squeaky Kleen Car Wash 519.99 View
[] | oarzerz021 Squesky Kleen Car Squesky Kleen Car Wash $19.99 View
[] | oarz9r2021 Bob's Burger Bob's Burger Joint Credit Card Expense 518.97 Match
04/29/2021-518.97 Bob's Burger Joint
[] | oar2ar2021 Norton Lumber And Norton Lumber and Building Materials | CC Bill Payment 1 $103.55 Match
04/24/2021 -5103.55 Norton Lumber af
[] | oansrzoz1 Tania's Nursery Tania's Nursery Expense 50 $82.45 - —
04/18/2021 -382.45 Tania's Nursery
[] | o05/202021 Amazon Uncategorized Expense $89.99 Add
[ | 051972021 Lara’s Lamination Uneategorized Expense §150.00 Add

QuickBooks Online automatically looks for a match for downloaded transactions that have
passed through the banking system. The match could be against a check, bill payment, deposit,
payment received from customer, etc. If upon a quick review you agree, you can match each one
individually by clicking Match under the Action column one at a time. Alternately, if you want to
enter several transactions in a row at one time, select the first transaction you want to enter, hold
your Shift key down and click the last transaction you want to enter. A black band at the top of
the grid will appear, allowing for batch actions to be taken on multiple transactions. Click
Accept. That matches the selected downloaded transactions against transactions that were
already entered into QuickBooks.
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11. Click the selection box for Bob’s Burger. Hold your Shift key down and click the selection box
for Tania’s Nursery.

By holding down your Shift key, QuickBooks Online selects all the transactions between Bobs
Burger Joint and Tania’s Nursery.

For review (7) Categorized Excluded

DATE DESCRIPTION PAYEE CATEGORY OR MATCH & SPENT RECEIVED ACTION

Takeatour  Go to bank register

05/06/2021 Squeaky Kleen Car Squeaky Kleen Car Wash £19.99 View
04/29/2021 Squeaky Kleen Car Squeaky Kleen Car Wash $19.99 View

04/29/2021 Bob's Burger Bob's Burger Joint Credit Card Expense $18.97 Match
04/29/2021 -$18.97 Bob's Burger Joint

04/24/2021 Norton Lumber And Nerton Lumber and Building Materials | CC Bill Payment 1 $103.85 Match
04/24/2021 -$103.55 Norton Lumber ar

04/18/2021 Tania's Nursery Tania’s Nursery Expense 50 $82.45 Match
04/18/2021 -$82.45 Tania's Nursery

05/20/2021 Amazon Uncategorized Expense $89.99 Add

05/19/2021 Lara's Lamination Uncategorized Expense $150.00 Add

12.In the Batch Actions black band, choose Accept.

For review (7) Categorized Excluded )

3 items selected

Those transactions move from the For Review tab to the Categorized tab. If you accepted any
transactions in error, click Undo in the Action column for those transactions. That will send them
back to the For Review tab.

For review (4) Categorized Excluded Take atour  Go to bank register
B alidstes v U} Alltransactions v | ‘ Q, |
(SR
D DATE v DESCRIPTION AMOUNT ADDED OR MATCHED RULE ACTION
D 04/29/2021 Bob's Burger -$18.97 Matched to: Credit Card Expense: Meals and Entertainment
D 04/24/2021 Norton Lumber And -$103.55 Matched to: CC Bill Payment: Accounts Payable (A/P) 1 04/2, Undo
D 04/18/2021 Tania's Nursery -$82.45 Matched to: Expense: Job Expenses:Job Materials:Plants an Undo
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13. At the top of the screen, click the Checking card to ensure you are now reviewing that account.

e Checking v
e

~N
Checking 8¢ Savings 5 Mastercard o
-$3,621.93 A $200.00 $304.96
BANK BALANCE Updated moments ago BAMK BALANCE Updsted moments ago BAMK BALANCE Updated moments ago
$1,201.00 25 $800.00 1 $157.72 7

\ IN QUICKBOOKS ) IN QUICKBOOKS IN QUICKBOOKS

14. Go to the For Review tab and click the Description column header twice. Now the transactions
in this tab are sorted reverse-alphabetically by the contents of the Description field.

A

I For review (25) ICalegorized | Excluded ) Take atour  Go to bank register

[ﬁ Alldates v Hm All transactions (25) s H Q

D DATE I DESCRIFTION‘ v J]"] I PAYEE CATEGORY OR MATCH SPENT RECEIVED ACTION

15. Scroll down until you see the two expense transactions for A Rental (one for $1,200 and one for
$800). QuickBooks Online does not know the vendor name or the account to use. Click one of
those expenses. The row expands to allow you to categorize it manually. You will see AT RENTAL
in the Bank Detail and that text was also automatically copied to the Memo field.

Banking  App Transactions  Rules  Tags  Receipts
04/21/2021 -52,000.00 Brosnahan Insurance Agel
[]  03nar2021 Books By Bessie Books by Bessie Uncategorized Expense $55.00 Add
[ | 0er19/2021 Books By Bessie Books by Bessie Uncategorized Income $55.00 Add
D 04/22/2021 Books By Bessie Pam Seitz Expense 76 $75.00 Match
04/24/2021 -575.00 Pam Seitz
D 05/20/2021 A Renta Uncategorized Income $200.00 Add
D 05/20/2021 A Renta Uncategorized Expenze $1,200.00 Add
D 04/27/2021 A Rental Uncategorized Expense $800.00 Add
@) Categorize () Findmateh  (O) Recordastransfer () Record as credit card payment X
Vendor/Customer @ Catsgory* @ Customar/project @
A Uneategorized Expense - - [ Billable
Tags @ Manage tags
Memo
AT RENTAL
B Addattachment (@) Crestearde () Exclude Split m
e
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16. Type A1 Rental in the Payee field. There is no name in QuickBooks Online for A1 Rental. Add it
on the fly as a new vendor by clicking +Add A1 Rental. Ignore the Details hyperlink and Save
this name as a new vendor.

@ Categorize O Find match O Record as transfer O Record as credit card payment
Vendor/Customer (&) Category * @ Customeriproject (3
AT Rental ~ lUncategorized Expense A v
+ Add A1 Remal@ Menage tags
New Name
*Name
A1 Renta'
Type
Vendor -
+ Details Save
Ve ~
| Import your Gmail contacts |
M ey
17. Choose Equipment Rental as the posting account.
D 05/20/2021 ARental A1 Rental Job Expenses:Equipment Rental $1,200.00 Add
\:‘ 04/27/2021 ARental AT Rental Job Expenszes:Equipment Rental $800.00 Add
@ Categorize () Find match () Record as transfer () Record as credit card payment X
Vendor/Customer (@) Category * @ Customar/project @
A1 Rental v Job Expenses:EquipmentR ¥ v | [ eillable
Tags @D Menage tags
Memo
A1RENTAL

BANK DETAIL A1 RENTAL

B Add attachment ® Createaru

e (@ Exclude 4D Categorization history [ split m]
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As soon as you do that, QuickBooks Online assumes you want the other expense transaction for
A Rental to use the A1 Rental vendor and post to Equipment Rental. If you need to split a
transaction, you can do so by clicking Split.

You could click Add to add each transaction individually or click the selection boxes in the far-left
column next to each transaction, then in the black Batch Actions band choose Accept as you did
earlier in this exercise.

Rules

After you categorize a vendor’s bank-fed transaction for the second time, QuickBooks Online will
prompt you with a Suggested rule, which you can dismiss (by clicking the x in the top right corner) or
create a rule or edit one. You can also click Don't show me this again if you don't want QuickBooks
Online to suggest rules for you.

vy
&2

|s A Rental always Job
Expenses:Equipment Rental?
Create a rule to apply these details to similar transactions in the future.

PAYEE

A1 Rental -

To keep more accurate records, add a payee to this rule.

Auto-add () @

Don't show me this again
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We'll cover rules now.

1. Locate Hicks Hardware, an uncategorized expense for $24.38. QuickBooks Online does not
know where to post this transaction.

2. Click Rules from the horizontal list of sub-tabs and choose New rule.

al @

[ PRIORITY @ a | RULE NAME APPLIEDTO CONDITIONS SETTINGS AUTO-ADD STATUS  ACTIONS

Use rules to save time

Make rules for your frequently occurring transactions and tell QuickBooks exactly what should happen when conditions are met. Create a rule

3. Enter Hicks Hardware as the Rule name and specify that this rule will apply to Money out
transactions. Choose All bank accounts (which means all bank and credit card accounts). If you
wanted to fine-tune this rule and have it apply to only selected bank or credit card accounts, you
would click the drop-down next to All bank accounts and place a checkmark next to all accounts
to which this rule is to apply.

4. Enter Hicks Hardware as the contents of the Description condition field (you may have to check
the drop-down next to Bank text to reveal Description).

5. Select Supplies as the Category and Hicks Hardware as the Payee.

6. If you want the rule to populate more fields, click the +Assign more hyperlink.
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Create rule

Rules only apply to unreviewed transzactions.

What do you want to call this rule? *

l Hicks Hardware

Apply this to transactions that are

l Money out

| in

All bank accounts w ‘

and include the following:

+ Assign more

Auto-add ()

l Description Vv l l Contains v l l Hicks Hardware l
+ Add a condition

Then Assign v

Transaction

type Expense v l

Category Supplies ¥ | Adda split
Payee ‘ Hicks Hardware| v ‘

Tags

Automatically confirm transactions this rule applies to

7. Check the toggle next to Auto-add.

8. Click Save. You will see a confirmation that the rule has been added, as well as any transactions
that have been added automatically to the company’s books as a result of this new rule.

You can click Edit in the Action column to see this rule and make any changes.

Banking  AppTransactions  Rules  Tags  Receipts

Rules

[[] | PRIORTY ®a  RULENAME APPLIEDTO
O 1 Hicks Hardware

CONDITIONS

Description contains "Hicks Hardware”

al @
SETTINGS AUTO-ADD  STATUS = ACTIONS
Set Category to “Supplies”, Sst Peyes to "Hicks Hardware” ([ Active I Eilit v I
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Edit rule

Rules only apply to unreviewed transactions.

What do you want to call this rule? =

[ Hicks Hardware I

Apply this to transactions that are

in

[ Money out v

and include the following:

All bank accounts w ‘

Topic 2: Expense and Purchase Transactions

[ Description v l I Contains W ] l Hicks Hardware l

+ Add & condition

Then Assign Vv

Transaction

Expense

+ Assign more

Auto-add ()

type

Category Supplies

Payee Hicks Hardware
Tags

Automatically confirm transactions this rule applies to

¥ | Add asplit

If you ever want to delete a rule or inactivate it, you can go back into the Rules tab. To keep the
rule but disable it for the time being, click Edit in Actions column on the far right, then slide the

Enable rule slider button to off:

Banking  AppTransactions  Rules  Tags  Receipis

Rules
[]  PRIORTY®a  RULENAME APPLIED TO CONDITIONS
O 1 Hicks Hardware Description contains *Hicks Hardware"

al @

SETTINGS AUTO-ADD STATUS | ACTIONS

Set Category to "Suppliss”, St Payss 10 "Hicks Hardwars” [ Active Edit ¥

Copy

1-1of 1 items

Delete
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Banking  AppTransactions  Rules  Tags  Receipts

Rules
[[]  PRIORTY®a  RULENAME APPLIEDTO CONDITIONS
O 1 Hicks Herdware Description contsins "Hicks Hardwars"

Search by name or conditions Q] @&

SETTINGS AUTO-ADD STATUS = ACTIONS

Set Category to “Suppliss”, Set Payes to "Hicks Hardware” [ Dissbled

1-1 of 1 items

9. Back in the Rules window, click the Banking tab at the top.

@nking App Transactions Rules Tags Receipts
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10. Remember, you're still in the Checking account. Click the Categorized tab. Hicks Hardware
transactions now appear in this tab and indicate this posting was set by a rule. It also indicates, by
the green plus sign inside a picture of a document, that the rule added these transactions to the
books automatically without the need for further work by the user.

If we had not checked the box next to Automatically add to my books, you could see these
transactions in the For Review tab. They would be available to you to add each rule-categorized
transaction one at a time or via Batch actions. When you're just starting out with rules, you may
not want to choose auto-add, in order to have more control over what is happening.

For review (21) Categorized Excluded Take atour  Go to bank register
B Alldates v If4  Alltransactions v | ‘ Q ‘
e E @

D DATE v DESCRIPTION AMOUNT ADDED OR MATCHED RULE ACTION
D 05/20/2021 ARental -$1,200.00 Added ta: Expense: Job Expenses:Equipment Rental 05. Undo
D 04/27/2021 A Rental -$800.00 Added te: Expense: Job Expenses:Equipment Rental 04, Undo
[] | oar2a/2021 Hicks Hardware $228.75 Added to: Expense: Supplies 04/24/2021 $228.75 [ o | Undo
[] | o04/06/2021 Hicks Hardware -$24.38 Added to: Expense: Supplies 04/06/2021 $24.38 [ o | Undo

11. If you look at each posting in the Added or Matched column, you'll see that Supplies was the
posting account. You can also click the purple hyperlink for each transaction to open it. In the

case below, you can see there is a blue hyperlink at the top left indicating it is matched to online
banking.

(< Expense DTakeatour 03 (D) Help ¥

1 online banking matches

Payee Payment account () AMOUNT

s—— « | [chectins - $228.75

Paymant date Payment mathod Refno,

04/24/2024 -

Tags @ Menage tags

v Category details

# CATEGORY (9) DESCRIPTION AMOUNT BILLABLE (7) TAX CUSTOMER ()

1 e T

2

=]

=]

Addlines | [ Claaralllines

This rule was very simple. You can create some complex rules. For example, if a Hicks Hardware
expense is less than $500, post to Supplies. Then create a second rule that states if a Hicks
Hardware expense is greater than $499.99, post to Equipment.
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You can also create rules for splits using percentages or amounts. For example, Cal Telephone
transactions should be split 60% to Telephone and 40% to Internet, if you added this new general
ledger expense account.

Then Assign Vv

Transaction

type ‘ Expense '

Split by

‘ Percentage (%) W |

Split detail #1

[

Percentage Category

4

‘ 60 ‘ Utilities: Telephone

Split detail #2

[

Percentage Category

40 Internet -

Add a line

Payee Cal Telephone v

When you click a transaction in the For Review tab, there are four radio buttons: Categorize, Find
Match, Record as transfer and Record as credit card payment. This last type appears only in Money
out transactions.

[ oarmsszoz1 Tim Philip Masonry Tim Philip Masonry Uncategorized Expense $666.00 Add
[ @ Categorize () Findmatch () Recordastransfer () Record as credit card payment ] X
Vendor/Custamer (3 Coregory * () Customer/praject ()
Tim Philip Masonry A Uncategorized Expense v ~ | [sillable
Tags @ Manage tags

Memo

TIM PHILIP MASONRY (NONE)

BANK DETAIL TIM PHILIP MASONRY (NONE)

0 cdires (@) Cement (@) Galdy @) Gl i (P
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You've been working with Categorize. If you think there should be a match, change the radio button
to Find match and QuickBooks Online will try to find matching transactions. If you can't find it,
perhaps the transaction was already reconciled in QuickBooks Online. If that's the case, and you
don’t want to enter that transaction because it's already in QuickBooks Online, check the box next to
this transaction then, in the black Batch Actions band that appears, click Exclude.

The Record as transfer button is used to indicate that this transaction is paying down the credit card
you select for the amount of this transaction.

The Record as credit card payment button is used to indicate this transaction is a transfer between
two accounts in this QuickBooks company file.
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Topic 3: Additional Transaction Types

ADDITIONAL TRANSACTIONS INITIATED USING THE +NEW MENU

There are other transaction types that can be accessed from the +New button. One such transaction
type the is time tracking. Time can be tracked using the Single Time Activity or the Weekly
Timesheet function. This feature can be used even if you are not signed up for QuickBooks Online
Payroll. You might also find a Time tab in the left navigation bar as well.

If Time tracking is not already enabled in your company, enable it via the gear icon - Account and
Settings > Advanced - Time tracking.

Time tracking is available in QuickBooks Online Essentials, Plus, and Advanced.

@
o Step by Step: Fill out a Single Time Activity

1. Select +New at the top of left navigation bar. (Note: you can also alternately select Time >
Overview in the left navigation bar.)

2. If necessary, select Show More.

3. Under Employees, select Time entry (it may also appear as Single time activity).

4. If you see a window giving you options for time tracking, select Stick with basic time.
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Time

Track time with
QuickBooks Time

(») See how it works - 1:58s

Basic time is included in your plan, but QuickBooks Time does
the tracking for you—plus so much more.

® See your team on the job with GPS

® Increase your billable time'

® Track worker mileage

® Communicate with your team in the mobile app

Stick with basic time

" Based on & survey of 4,904 customers in the U.S. in December 2019, On sversge, businesses that report 2n increase in billsble time sdded 11.46%

5. Select Add time entry.

How is your time tracking experience so far? Tell us what you think

SHORTCUTS

Take time tracking f i =
ake time tracking for a spin ‘

See how easy tracking hours can be for you and Add time entry Add employee
your team.
(¥) See how it works - 1:58s
o
Approve time Run report
SETUF TASKS

° You're on your way

Your time tracking setup has been customized.

° Your first hours are in the books

) View
You can group timesheets by Worker or Customer.

6. If no employees exist in this company, follow the prompts to add one or more employees. Make
sure that the First name, Last name, and Display name as fields in the Employee Information pop-
up window are populated. Click Save.
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Employee Information

Title *Firstname  *Lastname
John Smith
*Display name as
John Smith
Print on check as Use display name
John Smith

Address msp

Notes

e -,
| Cancel |
. vy

Email
Phone Mobile
Billing rate (/hr}

0.00 | [_]Billable by default
Social Security No.

Employee ID Gender

-
Hire date Released
Date of birth

Privacy

X

Save

7. Select the name of the employee whose time is being tracked.

8.

Add time

Smith, John

In the Add time window, select the date for which the time is being tracked. If the date is not
displayed in the default week, select the drop-down next to Last week and choose another date.
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¢ Back Ade

\

ast week v

g

This week
+ Last week
2TUE
Custom 0.00

—— J

9. Enter the Duration (number of hours) for this time entry. Alternately, slide the toggle for
Start/end times and enter the Start time and End time. You can enter the duration (e.g., 3.5
hours) either in HH:MM format (3:30) or in decimal format (3.5).

10. Select Add work details.
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11. In the Add work details window, enter the customer for whom the time is being tracked.

12. Enter the service being rendered during this time.

13. Optional: If the Make Single-Time Activity Billable to Customer preference is turned on in

Topic 3: Additional Transaction Types

Account and Settings > Advanced > Time Tracking, then slide the Billable (/hr) toggle if this

time entry is Billable.

14. Optional: If the preference to Show billing rate to users entering time is checked in Account

and Settings > Advanced - Time Tracking, you can view and edit the billable rate that will

appear on the invoice on which these billable hours appear.

15. Enter any extra description in the Notes field.

16. Select Done.

Add work details

Worker

John Smith

Duration

‘ 8:30 ‘

Customer

| Al City Library v \

Service

| Installation Labor v ‘

Motes

Start date
07/11/2021

Start/end times
w

Billable (/hr) D

Installed study pods

Done
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17.Back in the Add time window, if there are any other days for which you want to track time for this
employee during the displayed week, select the Add button.

< Back Add time for John X
Last week v TOTAL HOURS
8.50
Select day

IRV 12 MON - 13TUE 14 WED 15 THU 16 FRI 17 SAT

R 0.00 0.00 0.00 0.00 0.00 0.00

d Duration
Start/end ' 8.50
times L
All City Library S

Installation Labor

Cooe

18. Once you are finished entering all the time for this employee during the displayed week, select
Save (or choose the drop-down and select Save and close.
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@
o Step by Step: Make a Bank Deposit

1. Select +New at the top of left navigation bar.
2. If necessary, select Show More.

3. Under Other, choose Bank Deposit.

4. Select which bank account you are using for the deposit.

5. Fill'in the deposit date.

Topic 3: Additional Transaction Types

6. If there are any monies in Undeposited Funds, they will appear in the top part of the screen

under Select the payments included in this deposit.

7. Select any of the existing payments if they are part of the deposit which you are about to record.

8. Inthe Add funds to this deposit grid below, add any other payments received, which are typically
not sales-related transactions such as shareholder loans or insurance premium refunds.

9. If you are taking cash back that reduces the amount of the deposit, click in the posting account,
(e.g., Petty Cash or Owner’s Draw) and the amount of cash be taken. (Petty Cash was created as a

new “bank” account.)

(% Bank Deposit

Account Date

Checking ¥ | Balanes $1,201.00 03/20/2021

Select the payments included in this deposit
RECEIVED FROM + DATE Tree PAYMENT METHOD
CoolCars owzan02t Paymare

1-20F2

Payment

Ssioctall | [ Clearal

v Add funds to this deposit
# | RECEIVED FROM ACCOUNT DESCRIPTION

1 Brosnahan Insurance Agency insurance Fremium refund

[ Addiines | [ Clesralllinss

-

Memo

@ tHele X

AMOUNT

$4,562.52

MEMO REFNO. AMOUNT

Total 206252
Selocted Paymenta Tots! 206252

PAVMENT METHOD REFNO. AMOUNT

Chack 4434 300000 i

Other funds total $3,000.00

Cash back goss to Cash back memo Cash back amount

Raglanih pery cash -
Pemy Cash - e 500.00

Total $4,562.52
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By clicking Print at the bottom of the deposit form, you can also print a deposit slip and summary

using preprinted deposit slips. You can also print a summary on plain paper. This area is also used
for setting up and aligning these forms to be printed.

Print deposit slip and summary

Print deposit summary only

Setup and alignment

Print Make recurring

10. Click Save and close or Save and new.
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@
o Step by Step: Transfer Funds

Topic 3: Additional Transaction Types

Transfers are used to move monies between two company accounts. You could transfer funds from
one bank account to another bank account or from a bank account to a company credit card account

(although you can also use the Pay down credit card transaction type for that). You don't use the

Transfer feature to transfer from your bank account to your vendor’s bank account.

1.

2.

Select +New at the top of left navigation bar.
If necessary, select Show More.
Under Other, choose Transfer.

Select your source account in Transfer Funds From.

Fill in the amount of the transfer.
Fill in the date of the transfer.
Enter a memo if desired.

Click Save and close or Save and new.

Select your destination account in Transfer Funds To.

(%) Transfer

Transfer Funds From

Chacking -
Transfer Funds To
Savings -
Transfer Amount
1,000.00

Mema

Transfer 1o cover overdraft

(U Attachments  Maximum size: 20MB

Show existing

Balance
$5,763.52

Balance

$800.00

Date

05/20/2021
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@
o Step by Step: Record a Journal Entry

1. Select +New at the top of left navigation bar.

2. If necessary, select Show More.

3. Under Other, choose Journal Entry.

4. Enter a date.

5. Enter or accept the journal number.

6. Select an account and enter a debit or credit amount.

7. Enter a description if required.

8. On the next row, select another account and enter a debit or credit amount.
9. Enter a description if required.

10. Continue until you are done entering all debits and credits. Debits must equal credits.
11. If desired, enter a memo for the journal entry.

12. Select Save, Save and new or Save and close.

mx
( Journal Entry #1 & @ Her| X

08/31/2021

& ACCOUNT DEBITS CREDITS | DESCRIPTION NAME

1 Depraciation 100.00

2 TuckDepracistion 100.00 | D.

B

7

B 8 8 8 @ 2 B

H
Total 100.00 100.00

Addines | [ Clasrallines

Memo
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In QuickBooks Online, you can include multiple accounts receivable and accounts payable lines in a
journal entry. This works well, for example, if you want to trade a balance between a customer who is
also a vendor.

(5 Journal Entry #2 B @ e | X

Journsl ne.

# ACCOUNT DEBITS CREDITS  DESCRIPTION NAME
1 Accounts Receivable (A/R] 1,000.00 Joe Smith (Customer)
2 Accounts Fayable (A/F) 1,00000 Joe Smith (Vendor)

3

4

s

| =2 8 2| 8| =
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Topic 4: Other Tools

QuickBooks Online has tools that are especially helpful to maintain the accuracy of your QuickBooks
Online data. In this topic, you will learn where to access those tools and specifically learn about two

tools:

® Reconciliation history and Undo bank reconciliations tool

® Setthe closing date

<

o Step by Step: Bank Reconciliation History and Tools

1. Click Accounting > Reconcile from the left navigation bar.

@ quickbooks

Dashboard
Banking
Sales
Expenses
Projects
Payroll
Time
Reports
Taxes
Mileage

Accounting

My Accountant

—  Sample Company

0w Craig's De

Get things done B

SETUP GUIDE

Start invoicing

See how much you
Start tracking time
Connect with an acg
Add the finishing to
Chart of Accounts

Reconcile
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2. If you see the Match the books to the bank records screen, click Get started.

Chart of Accounts Reconcile

Match the books to the bank F ;|
records
"

Connected accounts are sasier to reconcile. Connact now

@ See how it works (7:50)

* Keep yourself on track
® Find holes in your accounting
® Get things tidy for tax time

...
—

3. Ifyou see the Reconcile like a pro screen, click Let’s do it.

Reconcile like a pro

Get your books and bank to agree with each other

— L -
L]
l,.f"_'“\,' L EE'
(S ) —
A
Open your statement Match your books to your Succese! Your account ie
statement reconciled

= Coren

4. You're going to reconcile the Checking account, so there is no need to change the account to

reconcile.
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5. Enter Statement Ending Balance $4,349.46 and Statement Ending Date of the last day of the
month before last and click Start reconciling.

Chartof Accounts  Reconcile

Chart of sccounts > Bank register > Reconcile

Reconcile Summary | History by account | Show me round

v
v
v

Reconcile an account

Open your statement and let's get started.

@ We know it takes time to get used to now stuff X

walk through the new supsrcharged raconciliation. Soon you'll be daing it

Which account do you want to reconcile?

Account

‘ Chacking -

Add the following information

Boginning balance [ Ending balance * Ending date *

5,000.00 4,349.46 04/30/2021

6. Make sure the filter at the top of the grid shows Statement ending date. Click the Payments tab
to display the payments and withdrawals from the account only.

= Sample Company © Bwepes @QHap Q L & @
Chart of accounts > Bank register > Reconcile
Reconcile  Checking D
Statement ending date: April 30,2021
$4,349.46 - $5,000.00
STATEMENT ENDING BALANCE CLEARED BALANCE _$650.54
DIFFERENCE
$5,000.00 _ $0.00 4 $0.00
BEGINNING BALANCE 0 PAYMENTS 0 DEPOSITS
Show me around
lear filter / View all | Payments | Deposits | Al )
DATE CLEARED DATE TYPE REF NO. ACCOUNT PAYEE MEMO @ PAYMENT (USD) DEPOSIT (USD)
01/20/2021 Bill Payment 10 Accounts Payabl. Robertson & Associates 300.00 =
02/11/2021 Expense 12 Legel & Professi. Robertson & Associstes 250.00
03/05/2021 Check 4 Automobile:Fuel Chin's Gas and Oi 5455
03/11/2021 Ssles Tex Payment Split Q1 Psyment 3850
03/11/2021 Seles Tox Payment split Q1 Peyment 3840
03/14/2021 Expense 9 Job Expenses:J. Tania's Nursery 89.09
03/14/2021 Check 12 Legal & Professi. Books by Bessie 55.00
03/20/2021 Check 5 Automobile:Fuel Chin's Gas and Oi 6201
03/21/2021 Expense 15 Job Expenses Tenis's Nursery 108.09
04/03/2021 Bill Payment 7 Accounts Payabl.. Hicks Hardware 250.00
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7. There are seven transactions that cleared in the Payments area during the statement period, and
you can clear each one individually by clicking a checkmark in the circle in the far-right column
for each transaction. Alternately, you can clear every transaction in a column by clicking a
checkmark in the circle at the top of that column rather than in each individual circle. Therefore,
clearing seven would be best done by clearing all nine, then un-checking the two that did not
clear. If you do clear all transactions by clicking a checkmark at the top of a column, you'll be
asked to confirm Yes, select all. Then you can un-check the ones that did not clear.

= Ssample Company © B Wbpe: @DHlp Q [N B O
Chartof accounts > Bank register > Reconcile
Reconcile Checking
Statement ending date: April 30,2021
$4,349.46 _ $4,174.46
STATEMENT ENDING BALANCE CLEARED BALANCE $1 75.00
DIFFERENCE
$5,000.00 B $825.54 " $0.00 f
BEGINNING BALANCE 7 PAYMENTS 0 DEPOSITS
Show me around
X Statement ending date Clear filter / View all (CPayments [ Deposis | Al )
DATE CLEARED DATE TYPE REF NO. ACCOUNT PAYEE MEMO @ PAYMENT (USD) DEPOSIT(USD)
01/20/2021 Bill Payment 10 Accounts Payabl.  Robertson & Associates 300.00 () =
02/11/2021 Expense 12 Legal & Professi Robertson & Associates 250.00 °
03/05/2021 Check 4 Automobile:Fuel Chin's Gas and Ol 5455 e
03/11/2021 Sales Tex Payment - split- Q1 Payment 38.50 (]
03/11/2021 Sales Tax Payment - Split- Q1 Payment 38.40 ()
03/14/2021 Expense ° Job Expensest] Taniz's Nursary 89.00 ®
03/14/2021 Check 12 Legal & Professi Books by Bessie 55.00 e
03/20/2021 Check Automobile:Fuel Chin's Gas and O 62.01
03/21/2021 Expense 15 Job Expenses Tenia's Nursery 108.09
04/03/2021 Bill Payment 7 Accounts Paysbl Hicks Hardwars 250.00
04/06/2021 Expense 8 Lendscapin, g Ser... Hicks Hardware 2436

8. Click the Deposits tab and mark only the first item on the list, the $175 deposit early in the
month. When the difference between the Statement Ending Balance and the Cleared Balance is
zero (and only when it is zero), click Finish Now.

= Sample Company QO Bwepee: @QHp Q L B O
Chart of accounts > Bank register > Recendle
Reconcile  Checking : Einish now .
Statement ending date: April 30,2021
$4,349.46 _ $4,349.46
STATEMENT ENDING BALANCE CLEARED BALANCE ° $0.00
DIFFERENCE
$5,000.00 _ $825.54 4 $175.00
BEGINNING BALANCE 7 PAYMENTS 1 DEPOSIT
Show me around
* Stetement ending date Clear firer / View al (Cpoymems | peposits J i )

DATE CLEARED DATE TYPE REFNO. ACCOUNT PAYEE MEMO @ PAYMENT (USD) DEPOSIT (USD)
01/28/2021 Receive Payment 1053 Accounts Receiv.. Bill's Windsurf Shop 175.00 ° -
03/30/2021 Recsive Payment 5664 Accounts Recsiv. Freeman Sporting Goods:55 Twi 86.40
03/30/2021 Sales Receipt 1008 Design income Kate Whelan 225.00
04/01/2021 Recsive Payment AczountsRecsiv Amy's Bird Sanctusry Ay clsims the pest contral did not aceur 105.00
04/17/2021 1886 A Cool Cars 694.00
04/19/2021 1003 Design income Dylen Sollfrank 337.30
04/22/2021 Split 218.75
04/22/2021 2064 Accounts Receiv. Trevis Waldron 103.55
04/22/2021 Accounts Receiv. Freeman Sporting Goods:55 Twi 50.00
04/22/2021 Split 408.00
04/24/2021 Split 868.15
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WARNING: if you click Finish Now with a non-zero difference, you will be creating an Auto Adjustment
transaction for the difference to be posted to the Reconciliation Discrepancies account, and you will
require your accountant user (who has access to QuickBooks Online Accountant and its exclusive tools)
to fix your problem. This may entail undoing one or more reconciliations, which can only be done with
access to QuickBooks Online Accountant. If you cannot finish reconciling to the point where you have a

zero difference, click Save for Later and come back to your reconciliation when you are fresher.

- WARNING: if you reconcile an account then change an amount on a cleared transaction (something you
should never do), that will also require someone with QuickBooks Online Accountant access to fix the
problem. Even if you change something else, like a date on a cleared transaction, if the date change is
major, it could cause problems that would require someone with QuickBooks Online Accountant access

to remedly.

o Step by Step: Set the Closing Date

There is no formal closing in QuickBooks; it's a perpetually running system.

QuickBooks Online knows, by what month you set as the first month in your fiscal year in the Account
and Settings, when to roll up last year’s income into Retained Earnings for reporting purposes.
However, when you have completed your review of the accounting records or sent the information
off to the accountant to complete the tax returns, you should protect any prior period data from
changing.

You do this by setting the Closing Date.

1. Click the gearicon > Account and Settings.

YOUR COMPANY LISTS TOOLS PROFILE
Account and settings @ All lists Order checks [3 Feedback
e L= e e Products and services Import data Privacy
Custom form styles Recurring transactions Import desktop data
Chart of accounts Attachments Export data
QuickBooks labs Custom fields Reconcile
Tags Budgeting
Audit log
SmartLook
Resolution center
You're viewing QuickBooks in Accountant view. Learn more Switch to Business view
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2. Click the Advanced tab. Click the pencil in the Accounting section (or click anywhere in that
section).

Accounting First month of fiscal year January 2
First month of income tax year Same as fiscal year
Accounting method Acerual

Close the books Off

3. Toggle Close the books and set a Closing date of 12/31/20.

4. Onthe drop-down list, choose Allow changes after viewing a warning and entering a
password.

5. Enter a Closing Date Password, confirm it and select Save. Click Done at the bottom of the

screen.
Accounting First month of fiscal year (@) Jenusry v
First month of income tax year Same as fiscal ysar
[Accmr‘tirg method (%) Accrusl W ]
Close the boaks (@ (;'

Closing date
12/31/2020
@)

Allow changes sfter viewing & warning and entering password v | (B

Password

Confirm Password

ene
I Cancel ‘ﬁ

It is a best practice to protect the information by setting a closing date password. When setting up
users in QuickBooks Online, there is no place in the user permissions to restrict users from changing
transactions before the closing date, even if a closing date password has been put in place and they
know the password. If someone does change a transaction before or up to the closing date, you can
use the Exceptions to Closing Date report, which is a subset of the Audit Log, to find what was
changed, by whom and when.
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Course Conclusion

You have just covered Course 3 - Recording Transactions in QuickBooks Online. This course has
been developed to help you train your clients how to use QuickBooks Online successfully.

By completing this module, your client should understand:

® Sales and Revenue Transactions
® Expense and Purchase Transactions
® Additional Transaction Types

@® OtherTools
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